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1 Introduction 
This course guide accompanies the Level 2 training sessions in Rhinoceros. This course is designed for  individuals 
who will be using and/or supporting Rhino.  

The course explores advanced techniques in modeling to help participants better understand how t o apply Rhinoôs 
modeling tools in practical situations.  

In class, you will receive information at an accelerated pace. For best results, practice at a Rhino workstation 

between class sessions, and consult the Rhino Help system from the  Help menu: Help Topi cs. 

Duration  

3 days  

Prerequisites:  

Completion of Level 1 training, plus three monthsô experience using Rhino. 

Course Objectives  

In Level 2, you learn how to:  

¶ Customize  toolbars  and  toolbar  collections  

¶ Create  simple  macros  

¶ Use advanced  object  snaps  

¶ Use dist ance  and  angle  constraints  with  object  snaps   

¶ Construct  and  modify  curves  that  will  be used  in  surface  building  using  control  point  editing  methods  

¶ Evaluate  curves  using  the  curvature  graph   

¶ Use a range  of  strategies  to  build  surfaces  

¶ Rebuild  surfaces  and  curves   

¶ Control  surface  curvature  continuity  

¶ Create,  manipulate,  save  and  restore  custom  construction  planes  

¶ Create  surfaces  and  features  using  custom  construction  planes   

¶ Group  objects  

¶ Visualize,  evaluate,  and  analyze  models  utilizing  shading  features  

¶ Place text  around  an object  or  on  a surface  

¶ Map planar  curves  to  a surface  

¶ Create  3-D models  from  2-D drawings  and  scanned  images  

¶ Clean  up  imported  files  and  export  clean  files  

¶ Use rendering  tools  
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Schedule  A: 3 Classroo m  Days  

Day 1 Topic 

8-9:30 AM Introduct ion  and warm up exercise.  

9:30 AM-12PM Interface and customization  

12 -1PM Lunch  

1-2:30 PM NURBS topology and curve degree  

2:30  -5PM Curve and surface continuity  

Day 2 Topic 

8-10AM  History, advanced surfacing and 
CPlane  tools  

10AM -12PM More CPlanes, mapping objects to 
surfaces  

12 -1PM Lunch  

1-2: 30PM Surface analysis  

2:30  -5PM Putting it all together ðScoop 
exercise  

Day 3 Topic 

8-10AM  More CPlanes, mapping objects to 
surfaces  

10AM -12PM Surface analysis, direct surface 
manipulation  

12 -1PM Lunch  

1-3PM Blocks, troubleshooting, Meshing  

3 -5PM Rendering (time allowing)  

 

Schedule B: 6 Half Days (On - line Training)  

Session 1 Topic 

9-10 :45 AM Introduction and warm up exercise.  

11 AM -12:30PM  Interface and customization  

Session 2 Topic 

9-10 :45 AM NURBS topology and curve degree  

11 AM-12 :45 PM Curve and surface continuity  

Session 3 Topic 

9-10 :45 AM History, advanced surfacing and 
CPlane  tools  

11 AM-12 :45 PM More CPlanes, mapping objects to 
surfaces  

Session 4 Topic 

9-10 :45 AM Surface analysis  

11 AM-12 :45 PM Putting it all together ðScoop 
exercise  

Session 5 Topic 

9-10 :45 AM More CPlanes, mapping objects to 
surfaces  

11 AM-12 :45 PM Surface analysis, direct surface 
manipulation  

Session 6 Topic 

9-10 :45 AM Blocks, troubleshooting, Meshing  

11 AM-12 :45 PM Rendering ( time allowing)  
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Exercise 1ðTrackball m ouse ( w arm - up)  

1  Begin a new model, save it as Trackball.3dm .  

2  Model a trackball mouse on your own.  

The dimensions are in millimeter s. Use the 
dimensions as guides only.  

 

 





 

 

PART II: 
Interface Customization 
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2 Customizing Rhino 
This chapter discusses customizing Rhinoôs interface with the following tools:  

¶ Toolbar  layout  

¶ Macro  Editor  

¶ Shortcut  keys  

¶ Scripting  

¶ Template  files  

The toolbar layout  

 

The toolbar layout is the arrangement of toolbars containing command bu ttons on the screen. The toolbar layout 
is stored in a file with the .rui extension that you can open and save. Rui files contain command macros, icons in 
three sizes, as well as tooltips and button text. Rhino comes with a default toolbar file  and automat ically saves the 
active toolbar layout before closing unless the .rui file is read -only. You can create your own custom toolbar files  
and save them for later use.  

You can have more than one toolbar file  open at a time. This allows greater flexibility to di splay toolbars for 
particular tasks.  

Rhinoôs customization tools make it easy to create and modify toolbars and buttons. Adding to the flexibility is the 
ability to combine commands into macros to accomplish tasks that are more complex. In addition to tool bar 
customization, it is possible to set up command aliases and shortcut keys to accomplish tasks in Rhino.  

Exercise 2ðCustomizing Rhinoôs interface 

In this exercise,  we will create buttons, toolbars, macros, aliases, and shortcut keys that will be available to use 
throughout the class.  

To create a custom toolbar collection  

There are times that the standard commands and buttons do not do exactly what you want. For example, Zoom 
Extents will look at all of the objects in a model and then zoom to the extents of these objects. In this exercise, 
we will open a model that has several objects including some light objects.  

Let us  say we want to use Zoom Extents to zoom to the objects, but we do not want the command to consider the 
light objects. In this exercise,  we will make a  new toolbar with a button  that will Zoom Extents while ignoring any 
light objects in the model.  

1  Open  the model ZoomLights.3dm .  

2  From the Tools  menu, click Toolbar Layout .  

This opens the Rhino Options dialog on the Toolbars page.  
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3  Highlight the Default  toolbar file.  

 

4  On the Toolb ars  page click the File  menu, click Save As . 

5  Type Level 2 Training  in the File name  box  and click  Save . 

A copy of the current default toolbar file is saved with the new name.  

Toolbar files are saved with a .rui extension.  You will use this new toolbar file to do some customization.  
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In the Rhino Options dialog, on the Toolbars page, all the open toolbar files are listed along with a list of all 
the individual toolbars for the selected toolbar file.  

Check boxes show the curr ent state of the toolbars. A checked box indicates that the toolbar is displayed.  

 

To create a new toolb ar   

1  On the Toolbars  page click the Edit  menu, click New  Toolbar .  

2  In the Toolbars Properties dialog, name the toolbar Zoom , and click OK .  

A new single button toolbar appears.  



C H A P T E R  2  C U S T O M I Z I N G  R H I N O  

Rober t  McNeel  &  Assoc ia tes  12  

3  Close the Rhino Options  dialog.  

 

Another way to work with toolbars is to use the title ba r of a floating toolbar.  

4  Right - click  on the  title  bar of the new toolbar you created.  

A popup list of toolbar options and commands displays.  

 

 

To edit the new button  

1  Hold down the Shift key  and right - click  the smiley face button in the new toolbar.  

The Button  Editor  dialog appears with fields for commands for t he left and right mouse buttons, as well as 
for the tooltips.  

2  In the Button  Editor  dialog, click Image only . 

In the Text  box,  type Zoom No Lights .  
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3  For the Left mouse button  Tooltip , ty pe  
Zoom Extents except lights , for the Right mouse button toolt i p , type  
Zoom Extents except light s all viewports .  

 

4  In the  Left Mouse Button  Command  box, type  
!  _SetRedrawOff  _ SelNone  _ SelLight  _ Invert  _ Zoom  _ Selected  _ SelNone  _SetRedrawOn .  

5  In the Right Mouse Button Command  box, type  
!  _SetRedrawOff  _ SelNone  _ SelLight  _ Invert  _ Zoom  _ All  _ Select ed  _ SelNone  _SetRedrawOn .  
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To change the bitmap image for the button  

1  In the Button Editor  dialog, click the 
Edit ...  next to the button icon in the upper 

right to open the Bitmap Editor .  

The bitmap editor is a simple pain t 
program that allows editing of the icon 
bitmap. It includes a grab function for 
capturing icon -sized  pieces of the screen, 
and an import file function.  

2  In the Edit Bitmap  dialog, click the  File  

menu, click Import  Bitma p  to Fit , and 
select the ZoomNoLights _32 .bmp .  

You can import any bitmap image . If the 
bitmap is too large, it will be scaled to fit 
as it is imported.  

 

3  In the Edit Bitmap  dialog , make any 
changes to the picture, and click OK . 

Double -click on the color swatches to  the 
right of the standard color bar to access 
the Select Color dialog for more color 

choices.  

4  Click OK  in the Button  Editor  dialog.  
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To change the bitmap image to use an alpha channel  

Notice that the new buttonôs background color does not match the background color of the other buttons. We will 
change the image background using an alpha channel, so that it matches the Windows 3D Objects color like the 

other buttons.  

1  Hold down the Shift key  and right - click  the 
ZoomNoLights  button.  

2  In the Button  Editor  dialog, click Edit to 
open the Bitmap Editor .  

3  Left click the upper right color swatch to the 

right of the black color.  Change  the alpha 
color  number, labeled A , for the button color 
from 255  to 1.  

This will make the current paint color  
transparent.  

4  Change to the Fill  tool, then right - click  in 

the background area of the button image.  

5  Click OK  in the Edit Bitmap  dialog, and then 
click OK  in the Button Editor  dialog . 

The color matches the Windows 3D Objects 
color.  

 

To use the new button   

1  Click the ZoomNoLights  button.  

2  Use the button to zoom the model two ways.  

You will notice that it ignores the lights when doing a Zoom Extents .  

Rules for commands  in buttons  

You can enter the commands or comm and combinations in the appropriate boxes, using these rules:  

Item Sample Description 

Space  !_Line  A space is interpreted as Enter.  

Commands do not have spaces (for example, SelLight) but you must leave a space 
between commands . 

ñ  ʕ  If your command string refers to a file, toolbar, layer, object name, or directory for 

which the path includes spaces, the path, toolbar name, or directory location must 
be enclosed in double -quotes.  

! (Exclamation mark)  ! -_circle  An !  (Exclamation m ark) followed by a space is interpreted as Cancel. Generally, it is 
best to begin a button command with  an exclamation mark  ( ! )  if you want to cancel 
any other command that  may be running when you click the button.  

' (apostrophe)   View manipulation comman ds like Zoom can be run in the middle of other 

commands. For example, you can zoom and pan while picking curves for a loft. An 
'(apostrophe) prior to the command name indicates that the next command is a nest 
able command.  
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Item Sample Description 

_ (underscore)   An underscore  (_) runs a command as an English command name.  

Rhino can be localized in many languages. The non -English versions will have 
commands, prompts, command options, dialogs, menus, etc., translated into their 
respective languages. English commands will not work i n these versions. For macros 
written in English to work on all computers (regardless of the language of Rhino), the 
macros need to force Rhino to interpret all commands as English command names, 
by using the underscore.  

-  (Hyphen)  -_Sweep2  Commands with d ialogs can be run at the command line with command line options.  

To suppress the dialog and use command line options, prefix the command name 
with a hyphen ( - ).  

Pause   User input and screen picks are allowed in a macro by putting the Pause command in 
the macro. Commands that use dialogs, such as Revolve, do not accept input to the 

dialogs from macros. Use the hyphen form of the command ( -Revolve) to suppress 
the dialog and control it entirely from a macro.  

Note:  These rules also apply to scripts run using  the ReadCommandFile  command and pasting text at the 

command prompt.  More sophisticated scripting is possible with the Rhino Script plug - in, but quite a lot can 

be done with the basic commands and macro rules . 

Some very useful commands  for macros are  SelLa st , SelPrev , SelName , Group , SetGroupName , SelGroup , Invert , 
SelAll , SelNone , ReadCommandFile , and SetWorkingDirectory . 

To link a toolbar to a button  

1  Shift +right - click the Zoom Extents  button in the Standard  toolbar.  

2  In the  Button Editor dialog , click in the Linked toolbar  area, select Zoom  from the list, and click OK .  

Now the Zoom Extents button has a small black triangle in the lower right corner indicating it has a linked 
toolbar.  

3  Click and hold the Zoom Extents button  to fly out your newly created single button toolbar.  

If you close the Zoom toolbar you just created, you can always re -open it using the linked button.  
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4  Try the new linked button.  

 

To add a command to an existing button  

1  Hold the Shift key  and right - click  the Move  button on the Main  toolbar.  

2  In the Button Editor  dialog, in the Right Mouse Button Command  box, type  
! _Move _Pause _Vertical  

3  In the Edit Toolbar Button dialog, in the Right Tooltip  box, type Move Vertical . 

This button will allow you to duplicate objects in the same location. We will use this command several times 

during the class.  

4  Select one of the objects in the model and right - click  on the Move  button.  
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5  Move  the selected object vertically from the construction plane.  

 

Command aliases  

The same commands and macros that are available for buttons are also available for command aliases. Comma nd 
aliases are like using shorthand  in Rhino. They are commands and macros that  are activated whenever commands 
are allowed, but are often used as a keyboard shortcut followed by Enter , Spacebar or clicking the right mouse  
button.  

Use aliases for command s equences that you use often or frequently.  

Note:  When making aliases, use keys that are close to each other or repeat the same character 2 or 3 times, so 

they will be easy to use.  

To make a command alias  

1  Open  the model  Aliases.3dm .  

2  From the Tools  menu, click Options .  

3  In the Rhino Options  dialog, on the Aliases  page, you can add aliases and command strings or macros.  
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4  Click New  to make a new alias.  

We will make aliases to mirror selected objects vertically and horizontally across the origin of the active 
construction plane. These are handy when making symmetrical objects built centered on the origin.  

 

5  In the Alias  column , t ype m x .  

I n the Command Macro  column , t ype  ! _Mirror _Pause _XAxis  

The alias is in the left column and the command string or macro is in the  right column. The same rules apply 
here as with the buttons. Aliases can be used within other aliases' macros or button macros.  

6  Click New  to make another new alias.  

7  I n the  Alias  colum n, t ype m y .  

I n the Command Macro  column , t ype ! _Mirror _Pause _ YAxis .  

To try the new aliases  

Select some geometry and  type m x  or m y  and press Enter .  

If no objects are pre -selected, the Pause in the script prompts you to select objects, and an Enter will 
complete the selection set.  

Macro editor  

When making macros that are more complicated, it is good practice to use Rhinoôs built-in macro editor. Macros 
can be edited and run directly from the editor. This allows you to quickly test whether command options and 
syntax are correct.  
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To use the macro editor  

In the following example we will make a mirror macro that allows you to mirror across the  construction p lane. We 
will use the macro editor to build and test the macro before we add it to the Alias list.  

1  From the Tools  menu, click Command , then click Macro 
Editor .  

2  I n the macro editor  t ype  
! _Mirror _Pause _3Point 0 1,0,0 0,1,0 .  

3  To test the macro, click the Run   icon in the macro editor.  

4  If the macro runs as expected, select the text and copy it to 

the clipboard.  

5  Open the Options  dialog on the Alias  page and make a new 
alias mc . Paste the text from the macro editor into the alias 
command column.  

6  Select some  geometry and try the new alias  out. Type m c and 

press Enter .  

 

To Export  and Import Options  

There are times when you might want to copy all or some of the options from one computer to another. An 
example might be a desktop computer and a laptop computer. Th is is especially true for aliases, keyboard 
shortcuts, and display modes. Rhino has commands that Export options to a file as well  as Import options from a 
file.  

1  From the Tools  menu, click Export Options .  

2  In the Save As  dialog, for the File Name , type Level2_Options.  

The current options are saved to a file.  

3  Now , delete one of the aliases you previously made.  

4  From t he Tools  menu, click Import Options .  

5  In the Import Options  dialog, select the file you just saved .  

6  For the Options to import , click Aliases , Appearance , or any other options you wish to import.  

Check to see if the alias you deleted is back.  

Shortcut keys  

The same commands, command strings, and macros that you can use for buttons  and aliases  are also available 

for keyboard shortcuts. Shortcuts are commands and macros that are activated  by certain combinations of 
function key s, Ctrl, Alt, and alphanumeric keys . 

To make a shortcut key  

1  From the Tools  menu, click Options .  

2  In the  Rhino Options  dialog, on the Keyboard  page, you can add command strings or macros.  

3  Click in the column next to the F4  to make a new shortcut.  

4  Type _ Disable Object snap  _ Toggle  for the shortcut.  

This shortcut will make it easy  to toggle the state of running object snaps.  
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5  Close the dialog and try it out.  

There are several shortcut keys that already have commands assigned. The same rules apply here as with 
the buttons and aliases.  

 

Plug - ins  

Plug - ins  are programs that extend the functionality of Rhino.  Plug - in classifications  include:  

Included plug - ins   

Shipped  and installed with Rhino.  Some of these plug - ins are loaded, for example R hino Render, Render 
Development Kit, Rhino Toolbars and Menus, BoxEdit, etc. Others are installed, but not loaded. Most of these 
plug - ins are I mport/Export plug - ins. They  are generally enabled and will get loaded when they are used for the 

first time.  

Rhin o 5.0 Labs plug - ins  

Experimental plug - ins developed in -house. These plug - ins are being considered for inclusion in future service 
releases or the next version of Rhino. They are a vailable for download from the Rhino 5.0 Labs Tools  website.  

McNeel plug - ins  

Flamingo nXt, Penguin, Brazil (rendering) and Bongo (animation) are McNeel products that are available for 
purchas e. 

http://wiki.mcneel.com/labs/home
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Third - party plug - ins  

These are programs and utilities that are developed by third -party de velopers. Some of these are free, but 
most are available for purchase. A few of the programs are stand -alone applications that work with Rhino, but 

are not plug - ins. Generally , they add some specific capability to Rhino. For example  RhinoCam is a CAM 
appli cation, VRay is a rendering application, RhinoGold is jewelry design software, etc. For more information 
about these programs visit the Rhino  Resources  website.  
 

 

To load a plug - in  

For this example we have included a plug - in from the Rhino 5.0 labs page for you to install and use.  

1  From the Tools  menu, click Options .  

2  Click Plug - ins .  

A list of currently loaded and available plug - ins is displayed.  

3  On the Plug - ins  page, click Install . 

4  In the Load Plug - In  dialog, naviga te to the Level  2/ Models/ Plug - ins  folder, then, depending on which 
version of Rhino 5.0 youôre running, click either RhinoPolyhedra_x64. rhp  or RhinoPolyhedra_x 86 .rhp  
(needed for 32 -bit version of Rhino 5.0).  

5  To run the c ommand, type Polyhedron  on the command line.  

http://www.rhino3d.com/resources/
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6  In the Polyhedron  dialog, select one of the polyhedrons from the list, then click a center point and a radius 
point.  

 

To load a plug - in using drag and drop  

1  Open a Windows Explorer window.  

2  Navigate to the folder that has the plug - in you want to install.  

3  Simply  click and hold the plug - in file, drag it and drop it into the Rhino window.  
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Scripting  

Rhinoceros supports scripting using VBScript.  

To script Rhino, you must have some programming skills. Fo rtunately, VBScript is simpler to program than many 
other languages, and there are materials available to help you get started. VBScript is a programming language 
developed and supported by Microsoft.  

We will not cover how to write a script in this class,  but we will learn how to run a script and apply it to a button.  

The following script will list information about the current model.  

To load a script  

1  From the Tools  menu, click RhinoScript , then click Load .  

2  In the Load Script  File  dialog, click Add .  

3  In the Open  dialog, select  CurrentModelInfo.rvb , then 

click Open .  

Note:  You may get a message that Rhino ñCannot find 

the script file CurrentModelInfo.rv b.  

If that happens you will need to include the full path to the 
folder where the script file is located  or add a search path 
in the Files  section of Rhino  Options .  

4  In the Load Script File  dialog, highlight 

CurrentModelI nfo.rvb , then click Load .  

 

5  Save the current model. If you do not  have a saved version 
of the model, no information is possible.  

6  From the Tools menu, click RhinoScript , then click Run .  

7  In the Run Script Subroutine  dialog , click 

CurrentModelInfo  and then click OK . 

A dialog describing the current information about this 
model displays.  
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To edit the script file  

1  From the Tools  menu, click RhinoScript , then click Edit .  

2  On the Rhino Script  Edit or  window, from the File  menu, click Open .  

3  On the Open  dialog, select CurrentModelInfo.rvb , then click Open .  

We will not be editing script files in this class. This exercise is to show how to access the editing feature if 
needed.  

4  Close  the Rhino Script  Edit or  window.  

To make a button that will load or run a script  

1  From the Tools  menu, click Toolb ar  Layout .  

2  In the Toolbars  dialog, check the File  toolbar  then close  the 
dialog . 

3  Right -click on the t itle bar  of the File  toolbar, then click New  
Button  from the popup menu.  

4  In the Button  Editor  dialog, in the Left Mouse Button 
Tooltip , type  
Current Model Information .  

5  In the Right Tooltip , type  
Load Current Model Information .  

 

6  In the Text  box , type Model Info . 

7  In the Left Mouse Button  Command  box, type  
! - _ RunScript (CurrentModelInfo)  

8  In the Right  Mouse Button Command  box, type  
! - _LoadScript ñCurrentModelInfo.rvbò 

 

To add a custom bitmap  

1  In the Button  Editor  dialog, click Edit .  

2  In the Edit Bitmap  dialog, from the File  menu, click Import  Bitmap , and Open  the 

CurrentModelInfo.bmp , then click Open .  

3  In the Button  Editor  dialog, click OK . 

4  Try the  new button.  

Template files  

A template is a Rhino model file you can use to store basic settings. Templates include all the information that is 
stored in a Rhino 3DM file: objects,  blocks, layouts,  grid settings, viewport layout, layers, units, tolerances,  render 
settings, dimension settin gs, notes, and any setting in document properties.  

You can use the default templates that are installed with Rhino or save your own templates to base future models 
on. You will likely want to have templates with specific c haracteristics needed for particular types of model 

building.  

The standard templates that come with Rhino have different viewport layouts or unit settings, but no geometry, 
and default settings for everything else. Different projects may require other sett ings to be changed. You can have 
templates with different settings for anything that can be saved in a model file, including render mesh, angle 
tolerance, named layers, lights, and standard pre -built geometry and notes.  

If you include notes in your templat e, they will show in the Open Template File  dialog .  
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The New  command begins a new model with a template (optional). It will use the default template unless you 
change it to one of the other templates or to any other Rhino model file.  

To change the template  that opens by default when Rhino starts up, choose New  and select the template file you 

would like to open  when Rhino starts, then check the Use this file when Rhino starts box.  

To create a template  

1  Start a new model.  

2  Select the Small Objects -  Inches.3dm  file as the template.  

3  From the Render  menu, click Current Renderer , and then click Rhino Render .  

To set the Document Properties  

1  From the File  menu, click Properties .  

2  In the Document Properties  dialog, on the Grid page , change the Snap spacing  to  0.1 , the Minor grid  
lines every  to 0.1 , the Major  lines every  to 10,  and the Grid l ine count  to  10 .  

 

3  On the Mesh  page change the setting to Smooth and slower .  
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4  On the Rhino Render  page, check Use lights on layers that are off .  

 

5  On the Units  page, change the Angle tolerance  to 0.5 , click OK .  

The en d tangent normals will be determined by this setting.  

 

To set up the layers  

1  Open the Layers  panel and rename Layer 05  to Spotl ights , Layer 04  to Curves , Layer 03  to Surfaces , and 
Default to Reference .  

Make the Spotl ights  layer current.  

Delete  Layer 01  and Layer 02  layers . 

 

2  Set up a spotlight so that it points  at the origin and is approximately 45 degrees in the Top viewport and tilted 
45 degrees in the Front viewport.  
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3  Use the m y  alias to mirror the light to make a second one.  

4  To make the Curves  layer the only visible layer, from the Edit  menu, click Layers  then click One Layer On . 
Select the Curves  layer.  

 

To set sav e notes  

1  From the Panel  menu, click Notes .  

Type the detai ls about this template in the Notes panel.  

2  From the File  menu, click Save As Template .  

Name the template Small Objects ïDecima l Inches -  0.001.3dm .  

 

This file with all of its settings is now available any time you start a new model.  
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To set a default template  

1  From the File menu, cli ck New . 

2  Select the template you want to use as the default template.  

3  In the Open Template File dialog, check the Use this file when Rhino starts  checkbox.  

You should make custom templa tes for the kind of modeling that you do regularly to save set up time.  

 





 

 

PART III: 
Advanced Modeling Techniques 
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3 NURBS topology 
The underlying geome try of NURBS surfaces have a rectangular topology in UV, or parameter  space. Rows of 
surface points, and parameterization, are organized in two directions (U and V). These two directions are 
crosswise to each other, at more or less 90 degrees on an ideal s urface, though this is not always possible. This 
structure is not always obvious when creating or manipulating a surface. Remembering this structure is useful in 
deciding which strategies to use when creating or editing geometry.  

Exercise 3ðTopology  

This exercise will demonstrate how NURBS topology is o rganized  and discuss some special cases that need 

consideration  when creating or editing geometry.  

1  Open  the model  Topology.3dm .  

There are several surfaces v isible on the 
current layer.  

2  Turn on the control points  of the simple 

rectangular plane on the left.  

It has four control points, one at each corner ð
this is a simple untrimmed planar surface that 
shows the rectangular top ology.  

3  Now , turn on the control points  of the, curvier  
surface.    

There are many more points, b ut it is clear that they are arranged in a rectangular fashion.  

1  Select the cylinder . 

It appears as a continuous circular surface, but 
it also has a rectangular boundary.  

2  Use the ShowE dges  command (Analyze menu: 
Edge Tools > click Show Edges)  to highlight the 

surface edges.  

Notice that there is a seam highlighted on the 
cylinder. The seam that is highlighted 
represents two edges of the rectangle, while 
the other two edges are circular a t the top and 
the bottom. The rectangular topology is 

present here, also.  

  

3  Select the sphere.  

It appears as a closed continuous object.  

4  Use the ShowEdges  command to highlight the 

edges.  

Notice that there is a seam highlighted on the 
sphere. The highlighted seam represents two 
edges of a rectangular NURBS surface,  while 
the other two edges are collapsed to a single 
point at the poles. When all of the points of an 
untrimmed edge are collapsed into a single 

point, it is called a singularity .  
  

The rectangular topology is present here, also, though very distorted.  
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1  Turn on the Control Points  for the sphere.  

2  Zoom Target  (Vie w menu: Zoom > Zoom Target)  

draw a select window very tight around one of the 
poles of the sphere.  

3  Select the point at one pole of the sphere  and start 
the Smooth  (Transform menu: Smooth)  command.   

4  In the Smooth  dialog, uncheck Smooth Z , then 
click OK . 

A hole appears at the pole of the sphere. Thereôs 

no longer a singularity at this pole of the sphere. 
ShowEdges  will highlight this as an edge as well.  

 

 

5  Use the Home  key to z oom  back out.  

This is the fastest way to step back through view changes.  

To s elect points  

1  Open the Select Points  toolbar.  

2  Select a single point at random on the sphere.  

3  From the Select Points  toolbar, click Select U . 

An entire row of points is selected.  

4  Clear the selection  by clicking in an empty area and 
select another point on the sphere.  

 

 

5  From the Select Points  toolbar, click Select V . 

A row of points in the other direction of the 

rectangle is selected. This arrangement into u-  
and v -direction s is always the case in NURBS 
surfaces.  

6  Try the other buttons in this toolbar on your own.  
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Exercise 4ðTrimmed NURBS  

1  Open  the model Trimmed NURBS.3dm .  

This surface has been trimmed out of a much 
larger surface. The underlying four sided 
surface data is still available after a surface 
has been trimmed, but it is limited by the trim 
curves (edges) on the surface.  

2  Select the surface and turn on the control 
points , then drag a few control points.  

  

Control points can be manipulated on the trimmed part of the surface or the rest of the surface, but notice 
that the trimming edges move around as the underlying surface changes. The trim curve always stays on 
the surface.  

3  Use the Undo  command to undo the point manipulation.  

To remove the trims from a surface  

1  Start the  Untrim  (Surface menu: Surface Edit 
Tools > Untrim)  command . 

2  Select the single edge of the trimmed surface.  

The original underlying surface appears and 
the trim boundary disappears.  

3  Use the Undo  command to return to the 
previous trimmed surface.  

  

To detach a trimming curve from a surface  

1  Start the Untrim  command with the 
KeepTrimObjects  option set to Yes  (Surface  
menu: Surface Edit Tools  > Detach Trim) .  

2  Select the edge of the surface.  

The original underlying surface appears. The 
boundary edges are converted to curves, 

which are no longer associated with the 
surface.   

3  Undo , to return to the previous trimmed 

surface.    
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To shrink a trimmed surface  

1  Start the ShrinkTrimmedSrf  command (Surface menu: Surface Edit Tools  > 

Shrink Trimmed Surface) .  

2  Select the surface and press Enter  to end the command.  

The underlying untrimmed surface is replaced by a o ne with a smaller range 
that matches the old surface exactly in that range. You will see no visible 
change in the trimmed surface. Only the underlying untrimmed surface is 
altered.  
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4 Curve creation and continuity 
We will begin this part of the course by reviewing a few concepts and techniques related to NURBS curves that will 
simplify the learning process during the rest of the class. Curve building techniques have a significant effect on the 
surfaces that you build from them.  

Curve degree  

The degree of a curve refers to the highest degree polynomial in the equation for the curve. In practice it relate s 
to the extent of the influence a single control point has over the length of the curve.  

For higher degree curves, a control  point has less local influence and a more broad influence over the entire the 
length of the curve . It also has higher internal continuity.  

In the example below, the five curves have their control points at the same six p oints. Each curve has a different 

degree. The degree can be set with the Degree option in the Curve  command.  

Exercise 5ðCurve degree  

1  Open  the model Curve 
Degree.3dm .  

2  Use the Curve  command (Curve 
menu: Free -Form  > Control Points)  
with Degree  set to  1 , using the 

Point  object snap to snap to each 
of the points.  

3  Repeat the Curve  command with 
Degree  set to 2 .  

 
Degree 1: Control points on curve ð
no bending.  

 
Degree 2: Control points off 
curve.  

4  Repeat the  Curve  command with 

Degree  set to  3 .  

5  Repeat the  Curve  command with 
Degree  set to  4 .  

 
Degree 3  

 
Degree 4  

6  Repeat the Curve command with Degree set to 5 . 

 
Degree 5 
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Analyzing the curvature of a curve  

1  Use the CurvatureGraph  command (Analyze 
menu: Cu rve  > Curvature Graph On)  to turn on the 

curvature graph for one of the curves. Set the 
DisplayScale  to a number that shows the graph as 
in the illustration ðbetween 110 -120 should work 

well.  

The graph indicates the curvature on the curve ð
this is the invers e of the radius of curvature. The 
smaller the radius of curvature at any point on 
the curve, the larger the amount of curvature.  

 

 

2  Turn on the control points for the 
curve you have graphed and v iew the 
curvature graph as you drag some 
control points. Note the change in the 
curvature hairs as you move points.  

3  Repeat this process for each of the 

curves. You can use the Curvature 
Graph  dialog buttons to remove or 
add objects from the graph display.  

  

Note:  

¶ Degree  1  curves  have  no  curvature  and  no  graph  displays.  

¶ Degree  2  curves  are  internally  continuous  for  tangency ðthe  steps  in  the  graph  indicate  this  condition.  Note  
that  only  the  graph  is stepped  not  the  curve.  

¶ Degree  3  curves  have  continuous  curvature ðthe  graph  will  not  show  steps  but  may  show  hard  peaks  and  
valleys.  Again,  the  curve  is not  kinked  at  these  places ðthe  graph  shows  an abrupt  but  not  discontinuous  
change  in  curvature.  

¶ In  higher  degree  curves,  higher  levels  of continuity  are  possible.  

¶ For example,  a Degree  4  curve  is continuous  in  the  rate  of  change  of  curvature ðthe  graph  doesnôt show  

any  hard  peaks.   

¶ A Degree  5  curve  is continuous  in  the  rate  of  change  of  the  rate  of  change  of  curvature.  The  graph  doesnôt 
sho w any  particular  features  for  higher  degree  curves  but  it  will  tend  to  be smooth.  

¶ Changing  the  degree  of  the  curve  to  a higher  degree  with  the  ChangeDegree  command  with  
Deformable=No  will  not  improve  the  internal  continuity,  but  lowering  the  degree  will  adversely  affect  the  

continuity.  

¶ Rebuilding  a curve  with  the  Rebuild  command  will  change  the  internal  continuity.   
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Curve and surface continuity  

Since creating a good surface so often depends upon the quality and continuity of the input curves, it is 

worthwhi le clarifying the concept of continuity among curves.  

For most curve building and surface building purposes we can talk about four useful levels of continuity:  

Not continuous  

The curves or surfaces do not meet at 
their end points or edges. Where there 
is n o continuity, the objects cannot be 
joined.  

  

Positional continuity (G0)  

Curves meet at their end points, 
surfaces meet at thei r edges.  

Positional continuity means that there 
is a kink at the point where two curves 

meet. The curves can be joined in 
Rhino into a single curve but there will 
be a kink and the curve can still be 
exploded into at least two sub -curves.  

  

Similarly two surfaces may meet along a common edge but will show a kink or seam, a hard line between the 
surfaces. For practical purposes, on ly the end points of a curve or the last row s of points along the  edge s of two  

untrimmed surface s need to match to determine G0 continuity.  

Tangency continuity (G1)  

Curves or surfaces meet and the 
directions of the tangents at the 
endpoints or edges is th e same. You 

should not see a crease or a sharp 
edge.  

Tangency is the direction of a curve at 
any particular point along the curve  

  

Where two curves meet at their endpoints the tangency condition between them is determined by the direction in 

which the curves are each heading exactly at their endpoints. If the directions are collinear, then the curves are 
considered tangent. There  is no hard corner or kink where the two curves meet. This tangency direction is 

controlled by the direction of the line between the end control point and the next control point on a curve.  

In order for two curves to be tangent to one another, their endpo ints must be coincident (G0) and the second 
control point on each curve must lie on a line passing through the curve endpoints. A total of four control points, 
two from each curve, must lie on this imaginary line.  
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Curvature continuity (G2)  

Curves or surfa ces meet, their tangent 
directions are the same and the radius 

of curvature is the same for each at 
the end point.  

  

Curvature Continuity includes the above G0 and G1 conditions and adds the further  requirement that the radius of 
curvature be the same at the common endpoints of the two curves. Curvature continuity is the smoothest 
condition over which the user has any direct contr ol, although smo other relationships are possible.  

For example, G3 continuity means that not only are the conditions for G2 continuity met, but also that the rate of 
change of the curvature is the same on both curves or surfaces at the common end points or edges . 

G4 means that the rate of change of the rate of change is the same. Rhino has tools to build such curves and 
surfaces, but fewer tools for checking and verifying such continuity than for G0 -G2.  

G5+ has no visible evidence of more continuity.  

Curve continuity and curvature graph  

Rhino has two analysis commands that will help illustrate the difference between curvature and tangency. In the 
following exercise,  we will use the CurvatureGraph  and the Curvature  commands to gain a better 
understanding of t angent and curvature continuity.  

To show continuity with a curvature graph  

1  Open  the model Curvature_Tangency.3dm .  

There are five sets of curves, divided into three groups.  

One group has positional (G0) continuity at th eir common ends.  

 

Group (a -c) has tangency (G1) continuity at 

their common ends.  
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Group (b -  d) has curvature (G2) continuity at 
their common endpoints.   

  

2  Use Ctrl+A  to select all of the curves. Then, turn on the Curvature Graph  (Analyze 
menu  > Curve  >Curvature Graph On)  for the curves. Set  the Display Scale  in the 
floating dialog to 100  for the moment. Change the scale if you cannot  see the 
curvature hair.  

The depth of the graph at this setting shows, in model units, the amount of curvature 
in the curve.  

3  First, notice the top sets of curves ( a -b ). These have two straight lines and a cur ve in 
between.  

The lines do not show a curvature graph ðthey have no curvature.  

 

The image just to  the right shows what is 
meant by the curvature not being 

continuous ðthe sudden jump in the curvature 

graph indicates a discontinuity in curvature.  

Nevertheless the line -arc - line is smoothly 
connected. The arc picks up the exact 
*direction* of one  line and then the next line 
takes off at the exact direction of the arc at its 
end.  

On the o ther hand,  the G2 curves (b) again 

show no curvature on the lines, but the curve 
joining the two straights is different from the 
G1 case. This curve shows a graph that starts 
out at zero ðit comes to a point at the end of 
the curve, then increases rapidly b ut 
smoothly, then tails off again to zero at the 

other end where it meets the other straight. It 

is not a constant curvature curve and thus not 
a constant radius curve. The graph does not 
have a sudden jump in the curvature graph;  it 
goes smoothly from zer o to its maximum.  

 

The G1 middle curve is an 

arc. It shows a constant 
curvature graph as expected 
because the curvature of an 
arc never changes, just as 

the radius never changes.  

 

For the G2 middle curve , 

the graph ramps up from 
zero to some maximum 
height along a curve and 
then slopes back to zero , 

matching the zero curvature  
again on the other straight 
line.  

Thus , there is no discontinuity in curvature from the end of the straight line to end of the curve. The curve 
starts and ends at zero curvature just like the lines have. So, the G2 case not only is the direction of the 
curves the same at the endpoints, but the c urvature is the same there as well ðthere is no jump in 
curvature and the curves are considered G2 or curvature continuous.  
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4  Next, look  at the c  and d  curves.  

These are also G1 and G2 but are not straight 

lines so the gra ph shows up on all of the 
curves.  

Again, the G1 set shows a step up or down in 
the graph at the common endpoints of the 
curves. This time the curve is not a constant 
arcðthe graph shows that it increases in 
curvature out towards the middle.  

On G2 curves, t he graph for the middle curve 
shows the same height as the adjacent curves 
at the common endpoints ðthere are no abrupt 
steps in the graph.  

  

The outer curve on the graph from one curve stays connected to the graph of the adjacent curve.  

To show continuity with a curvature circle  

1  Start the Curvature  command (Analyze menu>Curvature circle)  and select the 
middle curve in set c .  

The circle that  appears on the curve indicates the radius of curvature at that 
location ðthe circle that  would result from the center and radius measured at 
that point on the curve.  

2  Drag the circle along the curve.  

Notice that where the circle is the smallest, the graph shows the largest 
amount of curvature. The curvature is the inverse of the radius at any point.  

 

3  Click the MarkCurvature  option on the command line.  

Slide the circle , snap to an endpoint of the curve , and click to place a 
curvature circle.  

4  Stop the command and restart it  for the other curve sharing the endpoint just 
picked.  

Place a circle on this endpoint as well.  

The two circles have greatly different radii. Again , this indicates a 

discontinuity in curvature.  These curves are G1 / tangent only, so the 
curvature at the tangent meeting point is different for the two curves, and 
that is  where the curvature graph would take a jump.   

5  Repeat the same procedure to get cir cles at the ends  of the curves in set  d .  

Notice that this time the circles from each curve at the common endpoint are 

the same radius. These curves are curvature continuous.  
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6  Lastly, turn on the control points for the middle 
curves in c  and d. Select the ñmiddleò control 

point on either curve and move it around.  

Notice that while the curvature graph changes 
greatly, the continuity at each end with the  
adjacent curves is not affected.  

The G1 curve graphs stay stepped , though , 
the size of the step changes.  

  

The G 2 curve graphs stay connected , 
al though there is a peak that forms there.  

  

 7  Look at the graphs for the G0  curves.  

Notice that there is a gap in the graph ðthis 
indicates that there is only G0 or positional 
continuity.  

The curvature circles, on the common 

endpoints of these two curves, are not only 
different radii , but they are also  not tangent ð

they cross each other. There is a discontinuity 
in direction at the ends . 

  

Exercise 6ðGeometric continuity   

1  Open  the model Curve Continuity.3dm .  

The two curves are clearly not tangent. Verify this with the continuity 
checking command GCon .  

2  Start the  GCon  command (Ana lyze menu: Curve  > Geometric Continuity) . 

3  Click near the common ends ( 1 and 2) of each curve.  

Rhino displays a message on the command line indicating the curves are out 
of tolerance ðthe endpoints of the two curves are no t close enough to each 
other to be considered the same.  

Curve end difference = 0.030 millimeters  
Radius of curvature difference = 126.531 millimeters 
Curvature direction difference in degrees = 10.277 
Tangent difference in degrees = 10.277 
Curve ends are out of tolerance. 

Often, imported curves are often "out of tolerance" and need this kind of 
repair for accurate modeling.  
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To make the curves have position continuity  

1  Turn on the control points for both curves and zoom in on the common ends.  

2  Turn on the Point  object snap and drag one of the end points onto the other.  

3  Repeat the GCo n  command.  

The command line message is different now:  

Curve end difference = 0.000 millimeters  
Radius of curvature difference = 126.771 millimeters 
Curvature direction difference in degrees = 10.307 
Tangent difference in degrees = 10.307 
Curves are G0. 

4  Undo  the previous operation.   

To make the curves have position continuity using Match  

Rhino has a tool for making this adjustment automatically in the  Match  command.  

1  To try this, start the Match  command (Curve menu: Curve Edit Tools  > 
Match) .  

2  Pick near the common end of one of the curves.  

3  Pick nea r the common end of the other curve.  

By default,  the curve you pick first will be the one that is modified to match 
the other curve. You can make both curves change to an average of the two 
by checking the Average Curves  option in the following dialog.  

 

4  In  the Match Curve  dialog, for Continuity  
check Position , for Preserve other end  check 
Position , check Average Curves .  

5  Repeat the GCon  command.  

The command line message indicates:  

Curve end difference = 0.000 millimeters  
Radius of curvature difference = 126.708 millimeters 
Curvature direction difference in degrees = 10.265 
Tangent difference in degrees = 10.265 
Curves are G0. 
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Exercise 7ðTangent continuity  

It is possible to establish a tangency (G1) condition between two curves by aligning the control points  in a 
particular way . The endpoints at one end of the curves must be coincident and these points in addition to the next 

point on each curve must fall in a line with each other. This can be done automatically with the Match  comman d, 
although it is also easy to do by moving the control points using the normal Rhino transform commands.  

We will use Move , SetPt , Rotate , Zoom Target , PointsOn  (F10 ), PointsOff  (F11 )  commands and the object 
snaps End , Point , Along , Between  and the Tab lock to move the points in various ways to achieve tangency . 

First, we will create some aliases that will be used in this exercise.  

To make Along and Between aliases  

Along  and Between  are one - time object snaps that are available in the Tools  menu under Object  snaps . They 

can be used only after a command has been started and apply to only one pick. We will create new aliases for 
these object snaps.  

1  In the Rhino Options  dialog on the Aliases  page, 
click the New  button  

2  I n the Alias  column, t ype a .  

In the Command macro  column, type _Along .  

3  In the Alias  column, t ype b .  

4  In the Command macro  column type _ Between .  

5  Close  the Rhino  Options  dialog.  

 

To change the continuity by adjusting control points using Rotate and the Tab direction lock  

The tab direction lock locks the moveme nt of the cursor when the tab key is pressed. It can be used for moving 

objects, dragging, or curve and line creation.  

To activate tab direction lock press and release the Tab  when Rhino is asking for a location in space. The cursor 
will be constrained to  a line between its location in space at the time the Tab key is pressed and the location in 

space of the last clicked point.  

When the direction is locked, it can be released with another press and release of the Tab , and a new, corrected 
direction set wit h yet another Tab  press.  

1  Turn on the control points  for both curves.  

2  Select the control point  (1)  second from the end 
of one of the curves.  

3  Start the  Rotate  command (Transform menu: 
Rotate) . 

4  Using the Point  object snap, select the common 

endpoints (2)  of the two curves for the Center 
of rotation .  

5  For the First reference point , snap to the 
current location of the selected control point.    
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6  For the Second reference  point , make sure 
the point object snap  is still active. Hover the 

cursor, but do not click, over the second point 

(3)  on the other curve. While the Point  object 
snap flag is visible on screen, indicating the 
cursor is locked onto the control point, press 
and release the Tab  key. Do not click with the 
mouse . 

  

7  Bring the cursor back over  to the other curve --  
notice that the position is constrained to a line 
between the center of rotation and the second 
point on the second curve ;  that is , the location 

of the cursor when you hit the tab key. You can 

now click the mouse on the side opposite the 
second curve.  

During rotation,  the tab direction lock knows to 
make the line from the center and not from 
the first reference point.  

The rotation end point will be exactly in line 

with the center of rotation and the second 
point on the second curve.  

  

To change the continuity by adjusting control points using the Between object snap  

1  Use the OneLayerOn  command to turn on only 
the 3 D Curves  layer .  

2  Check the continuity of the curves with the 
GCon  command.  

3  Turn on the control points  for both curves.  

4  Window select the common endpoints of both 
curves (1).  

5  Use the Move  command (Transform menu: 

Move)  to move the points.  
  

6  For the  Point to move from snap to the same 
point (1).  

7  For the Point to move to , type  b  and press 

Enter  to use the Between  object snap.  

8  For the  First point , snap to the second  
point  (2) on one  curve.  

9  For the  Second point , snap to  the second 
point  (3) on the other curve.  

The common points are moved in -betw een the 
two second points, aligning the four points.    
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10  Check the continuity.  

 

To change the continuity by adjusting control points using the Along object snap  

1  Undo  the previous operation.  

2  Selec t the second point ( 3)  on the curve on the 

right . 

3  Use the Move  command (Transform menu: 
Move)  to move the point.  

4  For the Point to move from , snap  to the 
selected point . 

  

5  For the Point to move to , type  A  and press 
Enter to use the Along  object snap.  

6  For the Start of tracking line , snap  to the 
second point (2) on the other curve.  

7  For the End of tracking line , snap to the 
common points (1).  

The point tracks along a line that goes through 
the two p oints, aligning the four points.  

  

8  Click to place the point.  

9  Check the continuity.  
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To edit the curves without losing tangency continuity  

With the Tab technique,  we can adjust the meeting point of the curves, or the shape of eithe r curve near the 
meeting point, without losing the G1 continuity.  

1  Window select the common  endpoints or select 
the second point on either curve . 

 Turn on the Point object snap  and drag the 
point(s) to the next one of th e four critical 
points . 

2  When the Point  object snap  flag shows on the 

screen, use the Tab  direction lock by pressing 
and releasing the Tab key without releasing the 
mouse button.  

  

3  Drag the point(s)  and the tangency is 

maintained since the drag direction is 
constrained to the Tab direction lock line . 

4  Release the left mouse button at any point to 
place the point (s) . 

  

Note:  To mai ntain G1 continuity make sure that any point manipulation of the critical four points takes place 

along the line on which they all fall.  

 
Once you have G1 continuity you can still edit the curves near their ends without losing continuity, using 
the Tab dir ection lock.  
 

This technique only works after tangency has been established.  

Exercise 8ðCurvature continuity  

Adjusting points to establish curvature  continuity is not as straightforward as  for tangency. Curvature at the end 

of a curve is det ermined by the position of the last three points on the curve, and their relationships to one 
another are not as straightforward as it is for tangency.  

To establish curvature or G2 continuity, the Match  command is the only practical way in most cases.  

To m atch the curves  

1  Use the Match  command (Curve menu: Curve 
Edit Tools  > Match)  to match  the magenta  (1) 

curve to the red  (2) curve.  Set Continuity  to 
Curvature , Preserve other end  to Curvature , 
and uncheck Average curves .  

When you use Match with Curvature checked 
on these particular curves, the third point on 
the curve to be changed is constrained to a 

position calculated by Rhino to establish the 
desired continuity.  
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The curve being changed is significantly 
altered in shape.  

Moving the third point by hand will break the 
G2 continuity at the ends, though G1 will be 
maintained  

  

Advanced techniques for controlling continuity  

There are two additional methods to edit curves while maintaining continuity  in Rhino. (1) The EndBulge  
command constrains points at the end to maintain continuity with the adjacent curve . (2) Adding knots will allow 

more flexibility when changing the curve's shape.  

To edit the curve with end bulge  

1  Right - click  on the Copy  button to make a duplicate of the magenta curve and 
then Lock  it.  

2  Start the EndBulge  command (Edit menu: Adjust End Bulge) . 

3  Select the magenta  curve.  

Noti ce that there are more points displayed than were on the original curve.  

The EndBulge  command adds more control points to the curve if the curve 
has less than the required control point count . 

 

4  Select the third point, drag it, and click to place 
the point, press Enter  to end the command.  

If the endpoint of the curve has G2 continuity 
with another curve, the G2 continuity will be 

preserved, because EndB ulge  preserves the 
curvature at the endpoint of the curve . 

  

Note:  Adjusting control points will work to match curvat ure only in the simple case of matching to a straight line.  
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To add a knot  

Adding a knot or two to the curve will put more points near the end so that the third point can be nearer the end. 
Knots are added to curves and surfaces with the InsertKnot  command.  

1  Undo  your previous adjustments.  

2  Start the InsertKnot  command  (Edit menu: Control Points  > Insert 
Knot) . 

3  Select the magenta  curve.  

4  Pick a location on the curve to add a knot in between the first two knot 
markers . 

In general, a curve or surface will tend to behave better in point editing 
if new knots are placed midway between existing knots, thus 
maint aining a uniform distribution.  

Adding knots also results in added control points.  

 

Knots and cont rol points are not the same thing and the new control points will not be added at exactl y the 
new knot location.  

The Automatic  option automatically inserts a new knot in each span 
exactly half way between existing knots."  

If you only want to place knots in some of the spans, you should place 

these individually by clicking on the desired loca tions along the curve.  

Existing knots are highlighted in white.  

 

5  Match  the curves after inserting a 
knot into the magenta  curve.  

Inserting knots close r to the end 
of curves will change how much 
Match  changes the curve.  
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5 Surface continuity 
The continuity character istics for curves can also be also applied to surfaces. Instea d of dealing with the end point, 
second, and third points, entire rows of points at the edge, and the next two positions away from the edge are 
involved. The tools for checking continuity between  surfaces are different from the simple GCon  command.  

Analyz ing  surface continuity  

Rhino takes advantage of the OpenGL display capability to create false color displays for checking curvature and 
continuity within and between surfaces. These tools are loca ted in the Analyze  menu, under Surface . The tool, 
which most directly measures G0 -G2 continuity between surfaces,  is the Zebra  command. Zebra analysis 
simulates reflection of a strip ed background on the surface.   

Note:  An OpenGL graphics accelerator card i s not necessary to use these tools, although they may work faster 

with OpenGL acceleration.  

Matching surface continuity  

The command used to establish G0, G1 or G2 continuity between surfaces is  the  MatchSrf  command . 

Match surface options  

Option  Descriptio n  

Average surfaces  Both surfaces are  modified to an intermediate shape.  

Refine match  Determines if the match results should be tested for accuracy and refined so 

that the faces match to a specified tolerance.  

Match edges by closest 
points  

The surface be ing changed is aligned to the edge it  is being matched to by 
pulling each edge point to the closest point on the other edge.  

Preserve other  end  If the surface does not have enough points its degree is raised (up to a 
maximum of 5), until there are enough points.  

Isocurve direction adjustment  

Specifies the way the parameterization of the matched surfaces is determined.  

Option  Description  

Automatic  Evaluates the target edge, then uses Match target isocurve direction if it is 
an untrimmed edge or Make perpe ndicular to target edge if it is a trimmed 
edge.  

Preserve isocurve direction  As closely as possible, keeps the existing isocurve directions the same as 

they were in the surface before matching.  

Match target isocurve 
direction  

Makes the isocurves of the s urface that is being adjusted parallel to those of 
the surface it matches.  

Make perpendicular to 

target edge  

Makes the isocurves of the surface that is being adjusted perpendicular to 

the edge being matched.  

Exercise 9ðSurface continuity  and MatchSrf  

The MatchSrf  comma nd takes surface edges as input  and  modifies one or both of the surfaces . You need to tell 

the command exactly which edge to change and then which edge to match to the target surface. We will match 
the white surface's edge to the green one first. Both the edge to change and the edge to match to are untrimmed 
on these surfaces.  

While MatchSrf  is generally used to adjust surfaces that are fairly close to being at the desired continuity , this  
example is somewhat exaggerated in ord er to clearly show the functionality and options.  



C H A P T E R  5  S U R F A C E  C O N T I N U I T Y  

Rober t  McNeel  &  Assoc ia tes  52  

1  Open  the model Surface Continuity.3dm .  

2  Start the MatchSrf  command (Surface menu: Surface Edit Tools  > 

Match) .  

3  Select the edge of the white surface on the edge nearest the green 
surface.  

4  Select the edge of the green surface near the same location as the 
selection point on the white surface edge  and press Enter .  

 

5  In the Match  Surface  dialog, choose Position  as the desired 

Continuity , choose None  for Preserve other end , uncheck Refine  
match , and choose Automatic  for Isocurv e direction adjustment .  

Make sure all other check boxes are unchecked.  

A shaded preview is automatically generated so you can see what the 

result will be like.  

 

6  Click OK . 

The edge of the white  surface is pulled over to match the edge of the 
green one.  
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To check the continuity with Zebra analysis  

1  Check the surfaces  with Zebra  analysis tool 

(Analyze menu: Surface  > Zebra) .  

This command relies on a n approximation of the 
surface for its display information.  

2  By default , the mesh generated by Zebra  may be 
too coarse to get a good analy sis of the surfaces.  If 
the display shows very angular stripes rather than 
smooth stripes on each surface, click the Adjust 

mesh  button on the Zebra  dialog.  

 

 

In general,  the analysis mesh should be much finer than the normal shade and render mesh meshes.  

It is a good habit to set these meshes the first time you use a surface analysis display mode in a model. This 

setting is then saved in the file.  

3  Use the detailed controls to set mesh parameters.  

For this type of mesh,  it is often easiest to zero out (disable) the Maximum angle setting and rely entirely on 
the Minimum initial grid quads setting. This number can be quite high but may depend upon the geometry 
involved.  

 

In this example, a setting here of 5000 to 10000 will generate a very fine and accurate mesh.  

4  The analysis can be further improved by joining the surfaces to be tested. Join  the two surfaces.  

This will force a refinement of the mesh along the joined edge and help the Zebra stripes act more 
consistently.  

There is no particular correlation between the stripes on one surface and the other except that they touch , 
indicating G0 continuity . 
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5  Undo  the Join .  

 

To match the surface to tangency   

1  Use the MatchSrf  command (Surface 
menu: Surface Edit Tools  > Match)  
again with the Tangency  option  for 
Continuity .  

When you pick the edge to match 
you will get direction arrow s that 
indicate which surface edge is being 
selected. The surface that the 
direction arrows are pointing toward 
is the surface whose edge is 
selected . 

  

2  Check the surfaces with Zebra  analysis.   
Rotate  the view to view along the seam.  

The ends of the stripes on each surface meet the ends on the other 
cleanly , though at an angle.  

This indicates G1 conti nuity.  

 

To match the surface to curvature  

1  Use the MatchSrf  command (Surface menu: Surface Edit Tools  > Match)  
with the Curvature  option.  
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2  Check the surfaces with Zebra  analysis.  

The stripes now align themselves smoothly across the seam. Each stripe 

connects smoothly to the counterpart on the other sur face.  

This indicates Curvature (G2) continuity.  

 

Note:  Doing these operations one after the other may yield different results than going straight to Curvature  
without first using Position . This  is because each operation changes the surface near the edge, so the 

next operation has a different starting surface.  

Add knots to control surface matching  

As in matching curves, MatchSrf  will sometimes distort the surfaces more than is acceptable in order  to attain the 

desired continuity. We will add knots to surfaces to limit the influence of the MatchSrf  operation. The new second 
and third rows of points will be closer to the edge of the surface.  

Surfaces can also be adjusted with the EndBulge  command.  

To add a knot to a surface  

1  Undo  the previous operation.  

2  Use the InsertKnot  command (Edit menu: Control Points  > Insert 
Knot)  to insert a row of knots near the end of the white  surface.   

When this command is used on a surface, it has more options. You 
can choose to insert a row of knots in the U -direction, the V -direction, 

or both. Choose Symmetrical to add knots at opposite ends of a 
surface.  

3  Use Matc hSrf  to curvature match the surface to the other . 

Notice that the new matched surface is different from  the old one.   

To adjust the surface using end bulge  

The EndBulge  command lets you edit the  shape of a surface without changing the tangent direction and the 
curvature at the edge of the surface. This is useful when you need to alter the shape of a surface that has been 
matched to another surface.  

EndBulge  allows you to move control points at a specified location on the surface. These points are constrained 
along a path that keeps the direction and curvature from changing.  

The surface can be adjusted equally along the entire selected edge or along a section of the edge. In th e latter 

case, the ad justment takes place at the specified point and tapers out to zero at either end of the range. Either 
the start or endpoint of the range can be coincident with the point to adjust, thus forcing the range to be entirely 
to one side of the adjustment point.  
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1  Start the EndBulge  command (Edit menu: Adjust End Bulge) . 

2  For the  surface edge to adjust , pick  the edge of the surface on the 

right.  

3  For the Point to edit , pick a point on the edge at which the actual 
adjustment will be controlled.  

You can use object snaps and reference geometry to select a point with 
precision.  

 

4  For the Start of region to edit , pick 
a point along the common edges to 
define the region to be adjusted.  

5  For the End of region to edit , pick 
another point to define the region to 

be adjusted.  

To select a range  at this point, slide 
the cursor along the edge and click 
at th e beginning and end points of 
the range. If the whole edge is to be 

adjusted equally, simply press 
Enter .  

  

6  For the Point to adjust , select one  of 
the points that are displayed.  

Rhino shows three points, of which 
you are allowed to manipulate only 
two. When you move the second 
point , Rhino also moves the third 

point that is not being directly 
manipulated in order to maintain 
the continuity.  If you move the third 

point it wonôt change the second 
point   

7  Drag the point and click to adjust the 
surface.  

  

If maintaining the G2 curvature -matching condition at the edge is not needed, use the Continuity=Tangency 

option to turn off one of the two  points available for editing. Only G1 will be preserved.  

8  Press Enter  to end the command.  
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To match an untrimmed surface to a trimmed surface  

1  Start the MatchSrf  command 

(Surface menu:  Surface Edit 

Tools  > Match) .  

2  Select the edge of the green  
surface on the edge nearest the 
blue  surface.  

The edge will not select and you 
will see the following message 

on the command line:   

Edge must be on the edge of a surface (not 
a trimmed edge). Select untrimmed surface 
edge to change ( MultipleMatches ). 

  

3  Ins tead,  select the untrimmed edge of the blue  surface on the edge nearest the green  surface.  

4  Select the trimmed edge of the green  surface near the same location as the selection point on the blue  surface 

edge.  

5  In the Match  Surface  dialog, 
choose Curvature  as the desired 
Continuity , choose None  for 
Preserve other end , check 
Match edges by  closest points , 

and choose Automatic  for 
Isocurve direction adjustment .  

Make sure all other check box es 
are unchecked.  

A preview is automatically 
generated so you can see what 
the result will be like.  

Notice that the blue surface does 
not include the entire  untrimmed 
edge of the green surface. It 
only extends as far as the 
closest point from the original  
surface.  
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6  In the Match Surface  dialog,  
un check Match edges by  closest 

points , and check Refine match .  

7  Change  the Isocurve direction 
adjustment  and the Preserve 
other end  options to see what 
happens  to the matched surface . 
When finished press OK . 

 

 

 

Surfacing commands that pay attention to continuity  

Rhino has several commands that that can build surfaces using the edges of other surfac es as input curves. They 

can build the surfaces with G1 or G2 continuity to those neighboring surfaces. The commands are:  

¶ NetworkSrf  

¶ Sweep2   

¶ Patch  (G1  only)  

¶ Loft  (G1  only)  

¶ BlendSrf  (G1  to  G4)  

The following exercises will provide a quick overview of these c ommands.  

Exercise 10 ðContinuity commands  

To  create a surface from a network of curves  

1  Open  the model Continuity Commands.3dm .  

On the Surfaces  layer,  two joined surfaces  have been trimmed leaving 
a gap. Th is gap needs to be closed up with continuity to the surrounding 
surfaces.  

2  Turn on the Network  layer , if it is not already on, and make it current.  

Several curves  already in place define the required cross sections of the  
surface.  

3  Use the NetworkSrf command (Surface menu: Curve Network)  to close 
the hole with an untrimmed surface using the curves and the edges of the 
surfaces as input curves.  
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4  For the Select curves in network , select the four edges that border the 
opening and the four curves inside the opening and press Enter .  

Note that there is a maximum of four edge curves as input. Yo u can also 
specify the tolerances or maximum deviation of the surface from the 
input curves.  

By default,  the edge tolerances are the same as the model's Absolute 
Tolerance setting. The interior curves' tolerance is set 10 times looser 
than that by default . 

 

5  In the  Surface From Curve 
Network dialog, c hoose  Curvature  
continuity for all the edges, and click 
OK . 

The surface that is created has 

curvature conti nuity on all four 

edges.  

6  Check the resulting surface with 
Zebra  analysis.  

  

To make the  surface with a two - rail sweep  

1  Use the OneLayerOn  command to 
open the Surfaces  layer by itself 
again, and then click in the layers 
panel of the status bar,  and select the 
Sweep2  layer.  

2  Start the Sweep2  command (Surface 

menu: Sweep 2 Rails)  and select the 
long surface edges as the rails . 

  

3  Select one short edge, the cross -
section curves,  and the other short 
edge as profiles.  

4  Choose Curvature  for both Rail 
curve  options . 

Since the rails are surface edges, 
the display labels the edges, an d the 

Sweep 2 Rails Options  dialog 
gives the option of maintaining 

continuity at these edges.    
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5  Click OK . 

6  Check the resulting untrimmed 

surface with Zebra  analysis.  

 

 

To mak e a patch surface  

The Patch  command builds a trimmed surface, if the bounding curves form a closed loop . Patch  can match 
continuity to G1 if the bounding curves are edges.  The Patch  command:  

¶ Can use  unlimited  curves  or  points  for  input  

¶ Ignores  noise  of  man y control  points  

¶ Is  good  for  scanned  data  

¶ Is  good  for  reverse  engineering  

1  Turn on the Surfaces , and Patch  

layers.  

 Turn all other layers off.  

2  Start the Patch  command (Surface 
menu: P atch) .  

3  Select the edge curves and the 
interior curves, and then press Enter .  

4  In the Patch Surface Options  
dialog,  set the following options:  

Set Sample point spacing  to 1.0 .  

Set Stiffn ess  to 1 .  

Set Surface U  and V  spans to 10 .  

Check Adjust tangency and 
Automatic  trim , and then  click OK . 

 

The nominal 3 -D distance 
between points sampled 

from input curves  

Rows and column s 

The bigger the number, the 
"stiffer" and more 

rectangular and planar the 
resulting surface will be  

Takes the structure of a 

selected surface  
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5  Join  the surfaces.  

 

6  Use the ShowEdges  command (Analyze menu  > 

Edge tools  >Show Edges)  to display naked edges.  

If there are naked edges between the new patch 
surf ace and the existing polysurface the settings 
may need to be refined.  

7  Check the results with Zebra  analysis.  

 

 

Exercise 11 ðPatch options  

To make a patch from an edge and points  

Patch  can use point objects as well as curves and surface edges as input. This exercise will use point and edge 
inputs to demonstrate how the Stiffness  setting works.  

1  Open  the model Patch Options .3dm .  

2  Start the Patch  command (Surface menu: Patch)  and select the two point  
objects and the top edge  of the surface as input.  

3  Check Adjust tangency  and Automatic trim , set the Surface spans  to 
10  in each direction.  

4  To get a good view of the two point objects, make the Front  viewport the 
active viewport and set it to a wir eframe  or ghosted  view.  

5  Set the  Stiffness  to 0. 1  and click the Preview  button.  
 

With lower setting for stiffness,  the surface fits through the points whil e maintaining tangency at the surface 

edge. This can show abrupt changes or wrinkles in the surface.  
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6  Set the Stiffness  to 5  and click the 
Preview  button again.  

With higher stiffness settings, the 
patch surface is made st iffer and it 
may not pass through the input 
geometry.  On the other hand, the 
surface is less apt to show abrupt 
changes or wrinkles, often making a 
smoother and better surface.  

With very high stiffness numbers, 
the edges also may have a tendency 
to pull a way from the intended input 
edges.    

High stiffness  number  = the more 
rectangular and planar the resulting 

surface will be  

Low stiffness  number  = the 
smoother ( fairer ) the resulting 
surface will be  

More spans = gr eater density  of 

control points  

  

Exercise 12 ðLofting  

To make a lofted surface  

The Loft  command also has built in options for surface continuity.  

1  Open  the model Loft.3dm .  

2  Start the Loft  command (Surfac e 
menu: Loft) .  

3  Select the lower edge curve, the 
curve, then the upper edge curve d, 
and press Enter .  

When picking the curves, pick near 
the same end of each curve. This 
will insure that you do not  get a 
twist in the surfa ce.  
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4  In the Loft  dialog, make sure the 
Style  is set to Normal , and check 

the boxes for Match start tan gent  

and Match end tangent  are both 
checked. Press Enter  when done.  

The new surface has G1 continuity 
to the original surfaces.  

 

 

 

Style:  

Loose ðsimilar to control point 
curve  
Straight ðsimilar to polyline  
Normal/Tight ðsimilar to 
interpolated curve  

5  Check the results with Zebra  analysis.  

 

Exercise 13 ðBlends  

The next command that pays attention to continuity with adjoining surfaces is 

BlendSrf .  

The three blends in this file will serve to illustrate the basic features of the 
BlendSrf  command. The controls inside BlendSrf  can be used to var y the 
character of the blended shape.  

 

To make a surface blend  (BlendSrf 1)  

In BlendSrf 1,  we will create the transition between the trunk lid and side surfaces of the car body.  

1  Open  the model Blend.3dm .  

2  Start the BlendSrf  command (Surface menu: Blend Surface) .  

3  For the  Select segment for first edge,  select an edge along the red 
poly surfac e of the car body as marked in the file.  

Notice that only one surface edge segment is selected initially, but we 
want to blend the full length of the gap between the white side surface 
and the red surfaces.  
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4  You can select the next edge segment by clicking on it, or by clicking on 
Next  at the command line.  

The edge from the adjacent surface is selected.  

5  Press Enter  to finis h the selection for the first edge.  

 

6  For the  Select segment for second edge , select the top edge of the 

white side surface at the end of the edge nearest you r initial pick for the 
first edge. Press Enter  to finish edge selection.  

The Adjust Surface Blend  dialog  with several controls appears.  

 

 

Adjust Surface Blend dialog  

The sliders refer to the tw o default shape curves at the ends of the 

blend . Clicking the lock icon will force both sides of the blend to be 
adjusted at the same time.  

A button  allows the user to add shape curves. These new shape 
curves have adjustable handles on them exactly like th e default 

shape curves.  

Note that while it is sometimes useful to add shape curves, you 
should try to add as few as possible to achieve the shape you want. 

Interpolation among the shape curves is better if they are not too 
close together.  

The radio buttons  are for setting the continuity at each side of the 
blend; the edges are labeled 1 and 2 in the viewport.  

There are check boxes for further options.  These options will be 
discussed later in a separate exercise.  

 

7  Uncheck the boxes for Same height and Planar sections . Make sure the continuity radio buttons are set to 
Curvature .  

There is a check box to show a preview of the blend surface.  

In the viewport, you wi ll notice a default pair of shape curves with 
points. These points are called handles.  

The number of handles  available on the shape curves varies according  to 
the settings in the dialog.  

For example, if the continuity is set to Curvature  (bold) for both sh ape 
curves 1 and 2, the curves will have six  points (three for each curve).  
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8  Try adjusting the handles on the shape curves. For example, at the rear 
of the c ar, make the blend sharper by moving the handles out so that 

they are crowded near the apex of the shape curve.  

The handles can be adjusted interactively on each shape curve to 
change the shape of the blend.  

Moving the handles  changes the shape on one side  of one shape curve.  

 

Pressing  Shift  while moving the handles forces both ends of the shape 
curve to be adjusted together. This is useful in maintaining symmetry on 
the blend shape.  

 

 

Pressing  Alt  while adjusting handles rotates the handles and thus the 
direction of the shape curve relative to the edge.  

 

Moving the handle  at an end of a shape curve changes the location of 
the shape curve.  
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Using the sliders in the dialog 
changes all shape curves 

together.  

The top slider modifies all the 
shape curves near the or iginal 
edge #1, and the lower slider  
modifies all the shape curves 
near the original edge #2.  

 

 

9  Adjust the settings in the dialog  
to the def ault value of 1.0 , and 

then press OK  to make the 
blend surface.  

 

 

To make a surface bl end (BlendSrf 2)  

Next , we will blend between the roof rail and the side window.  

1  Start the BlendSrf  command (Surface menu: Blend Surface) .  

2  For the  Select segment for first edge , s elect  an edge along the rear 
window of the car as marked in the file.  

Notice that only a small part of the edge is selected. Although the 
window is a single surface, the edges are split up into small pieces, 

making it inconvenient to select all of them.  

 

3  Use the All  option on the command line to force chaining the edge 
fragments together .  

Notice that  the edge of the roof panel is also added, since the edges are 

contiguous and tangent to one another.  

Press Enter  to finish the first edge selection.  
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4  For the  Select segment for second 
edge , select the edge at the top of 

the side window.  

Notice the default shape curve 
shows an S -shape at the lower end 
of the blend area.  

5  Press the Alt  key while dragging the 
handles to align the blend  curve  in a 
more natural way.  

  

To clean up the excess surfaces  

To clean up the excess surfaces, we will trim the surfaces to each other. Since the intersections of the surfaces do 

not go all the way to the edges of all of the surfaces, we can make intersection curves, join them, and then extend 
them as needed on the surfaces.  

1  Start the IntersectTwoSets  command (Curve  menu: Curve from 
Objects  > Intersect ion of Two Sets ) . 

2  As the first set of objects to intersect , select the side window and the 

roof blend surface you just completed. Press Enter .  

3  As the second set of objects to intersect  with the first set , select the 
first blend surface you made. Press Enter .  

4  Join  the resulting curves.  

5  Select the joined curve.  

6  Start Exten dCrvOnSrf  (Curve  menu: Extend Curve  > Curve on Surface )  
and choose the lower blend surface as the surface to extend on.  

 

7  Trim  the bottom of the side window, the lower end of the roof rail blend, 
and the side blend inside the roof and glass area.  

 

To make a surface blend (BlendSrf 3)  

Lastly, we will blend between the wheel arch and the side of the car.  

1  Start the BlendSrf  command 

(Surface menu: Blend Surface) . 

2  For the  Segment for first edge , 
select an edge of the wheel arch 
on the side of the car and Press 
Enter .  

3  For the  Segment for second 

edge , select the other edge of 
the wheel arch . 
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4  Change t he continuity settings in 
the dialog  so that one edge has 

Position  continuity (G0) and the 

other has Curvature  continuity 
(G2 ), and check the Preview  
checkbox.  

This will allow you to have a 
hard edge at one of the edges.  

 

 

5  Switch the continuity settings to 
the opposite edges to change the 

character of the blend.  

You will probably have to rotate 

the shape curves at both sides 
of the wheel arch so that they 
align with the bottom edge of 
the side.  

In this case, it is easier to do 
this in the front view.  

 

 

6  Press the Alt  key while dragging the 
handles to align the blend  curve to 
the bottom edge of the side.  

  

7  Press OK  in the dialog  to make the blend surface.  
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Exercise 14 ðBlend options  

To make a surface blend  

In the  following exercise , we will first make a surface blend that creates a self - intersecting surface. Then we will 

use the surface blend options to correct the problem.  

1  Open  the model BlendSrf Options.3dm .  

2  Start the BlendSrf  command (Surface menu: 
Blend Surface)  and se lect the deeply curved edges 
of the pair of surfaces marked 0 .  

  

3  In the dialog, make sure Same height 
is not checked , and the bulge sliders  
are set to 1.0 , and then  click Ok .  

4  Zoom  in on the surface you just 
created in  the Top  viewport.  

Look closely at the middle of the 
blend surface in this view using a 
wireframe viewport. Notice the blend 
has forced the surface to be self -
intersecting in the middle. The 

isocurves cross each other and make 
a pinch or crease here.  

 

 

Surface blend options  

To avoid self - intersecting or pinched surfaces when creating a blend you can Adjust Blend Bul ge  sliders, use 

Same height shapes , or use the PlanarSections  option.  

In the following examples,  we will look  at each of these options.  

To make a surface blend with options  

1  Start the  BlendSrf  command and  select the 
edg es of the pair of surfaces marked 1 .  

Adjust the sliders to make the bulge of the 

surface less than 1. A number between 0 .2  

and 0 .3  seems to work best.  

The profiles of the cross sections at each end 
of the blend as well as any you may add 
between will updat e to preview the bulge. 
Notice that the surface is not pinched in the 

middle.  
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2  Start the BlendSrf command and  select the 
edges of the  pair of surfaces marked 2 .  

Change the Bulge  to 0 .5 , but check  Same 

height shapes .  

The Same height shapes  option overrides 
the tendency of the blend surface to get fatter 
or deeper according to how fa r apart the 
edges are. The height will be the same in the 
center as it is at each end. This also has the 

effect of making the sections of the blend 
push out less and therefore not cross each 
other out in the middle area.   

 

3  Start the BlendSrf command and  select the 
edges of the pair of surfaces marked 3 .  

4  Pick the edges in the usual way.  

 Use the same bulge settings as the last pair of 
surfaces.  

5  Check  PlanarSections  in  the dialog  and 
uncheck Same height .  

You are now asked to define which plane the 
sections of the surface should be parallel to. 
This is defined by clicking two points in any 
viewport.  

 

 

6  Click once anywhere in the Top viewport  A  then with Ortho  on, click again in the 
Top viewport B  in the direction of the y-axis .  

The resulting surface has it s isocurves arranged parallel to the plane defined in 

the PlanarSections  po rtion of the command. The isocurves do not intersect in 
the middle of the surface since they are parallel the y-axis.  

 

Fillets, blends and corners  

In this exercise,  we will discuss a v ariety of ways to fill holes and make transitions using the NetworkSrf ,  Loft , 
Sweep1, Sweep2 , Blend , Fillet  and Patch  commands.  

While Rhino has automated functions for making fillets, several situations  take manual techniques. In this section, 

we will disc uss making corners with different fillet radii, variable radius fillets and blends, and fillet transitions.  
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Exercise 15 ðVariable r adius f illets  

To make a corner fillet with three  different radii:  

1  Open  the  model Corner Fillet.3dm . 

2  Use the FilletEdge command (Solid 
menu: Fillet Edge  > Fillet Edge)  to 
fillet edge (1) with a radius of 5mm .  

  

3  Use the FilletEdge  command (Solid 
menu: Fillet Edge > Fillet Edge)  to 

fillet edge (2)  with a radius of 2mm , 

and edge (3)  with a radius of 3mm , 
and the edge created by the previous 
fillet with a radius of 2.5mm .  

Change the value for 
CurrentRadius  before selecting the 
next edge.  

  

4  Use the AddHandle  option to add a 
2.0 radius handle at the end of edge 
2 , and a 3.0 radius handle at the end 
of edge 3 . 

5  Preview  the results, and then  press 

Enter  to make the fillet.  
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Exercise 16 ðVariable r adius  b lends and chamfers  

To make a variable radius blend  

1  Open  the model Sandal Sole.3dm .  

2  Use the BlendEdge command (Solid menu: Fillet Edge > Blend Edge)  to 
make a variable radius blend on the bottom of the sole.  Start with a 
radius of 3mm .  

3  Use the AddHandle  option to add additional radii around the bottom of 
the sole.  

Add another 3mm radius to the front of the sole and then add a 7mm 

radius to the instep on both sides.  

 

4  Preview  the blend and adjust  the 

handles as needed, and then  press 
Enter  to make the blend.  

  

To make an edge chamfer  

1  Use the ChamferEdge  command 

(Solid menu: Fillet Edge  > Chamfer 
Edge)  to make a  2mm  chamfer 

around the top edge of the sole.  

This command , like the FilletEdge  
command and the BlendEdge  
command , allow for the addition of 
handles with different values to 

create a variable distance chamfer.  

2  Preview  the chamfer and make 
adjustments as needed, then press 
Enter  to make the chamfer.  
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Exercise 17 ðFillet with patch  

To make a six - way fillet using a patch  

1  Open  the model Fillet Edge.3dm .  

2  Use the FilletEdge  command (Solid menu: Fillet 
Edge  > Fillet Edge) , with Radius=1 , to fillet all 
the joined edges at the same time.  

  

3  Use the Patch  command (Surface menu: Patch)  to fill in the opening at the 

center.  

4  Select all six edges to define the patch.  

5  In the Patch Options  dialog, check Adjust Tangency and Automatic Trim . 
Change the Surface U and V Spans  to 1 0 , and the Stiffness  to 2 .  

 

Note:  When the area to fill has more than four edges,  the Patch  command works better than the NetworkSrf  

command.  

Exercise 18 ðSoft corners  

There are several ways to approach making a soft box shape like the illustration below.  

In this exercise,  we explore two different methods to make the 
surf aces using the same underlying curves. Our design curves in this 
example are all tangent arcs.  

The first method will use the curves directly. For second method, we 
will  plan ahead and try to take into account the simple underlying 

shapes suggested by the d esign curves.  

The two approaches are different, but one is not inherently better or 
contradictory to the other.  
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To make a rectangular shape with a curved top and soft corners (Part 1 )  

1  Open  the model Soft Corners.3dm .  

2  Use the Join  command (Edit menu: 
Join)  to join the arcs that form the 
base rectangular shape.  

3  Change to the 03 Swe eps  layer.  

4  Use the Sweep1  command (Surface 
menu: Sweep 1 Rail)  to make the first 
surface.  

5  In the Sweep 1 Rail Options  dialog , 
check Closed sweep , then click OK .  

  

6  Repeat t he Sweep1  command to 
make the second surface.  

7  Pick the top edge of the  surface you 

just created, then select the cross -
sections in order, and press Enter .  

8  In the Sweep 1 Rail Options  dialog , 
change the Style  to Align with 
surface , and then  click OK . 

This will insure tangent continuity 

with the first surface.  
  

9  Use the Patch  command (Surface 
menu: Patch)  to fill in the opening a t 
the center.  

  

10  Select the surfaces you made.  

11  Star t the  EMap  command (Analyze menu  > Surface > Environment map) . 
Click Adjust mesh  and refine the mesh in a similar way that you did for 
the Zebra surface analysis command. Choose the Arches.png  or Space 
Needle.png  from the drop -down list in the EMap Options  dialog.  

12  Tumble the view around.  

Note the top surface has a pronounced X -shape in the pseudo -

reflections. The surface is not a clean interpretation of the original input 
curves -  there is this extra distortion across the  top surface.  So, even 
though we have  hit all the input curves, our surfaces are not necessarily 
very nice.  

 

To make a rectangular shape with a curved top and soft corners (Part 2)  

This time , we will look at the input curves and make some judgments about the best way to construct the 
surfaces.  

One thing to keep in mind is that it is more important to make our primary surfaces have good curvature 
characteristics, and less important for transit ional surfaces.  
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Primary surfaces will be the ones that define the overall shape . T hey tend to have relatively even curvature, and 
less curvature than the transitions . Transition surfaces , as the term implies, provide transitions between the 
primary shape s urfaces. These  surfaces  tend to have higher curvature than the primary surfaces . F illets and 

blends , for example , are generally added as transition surfaces.  

In this example, we have the four side surfaces and the top surface as primary surfaces. We will a dd the corners 
afterwards as fillets. Since in our example the input curves are entirely made up of tangent arcs, we can define 
the side and top surfaces as revolved surfaces. This type of surface is very exact and simple.  

1  Change to the  02 Separate Curves  
layer and turn all the  other layer s off .  

2  Hide  the fillet curve at each corner, 

and the green cross -section curves.  

3  Lock the red curves.  

4  Use the  Extend command  (Curve 
menu: Extend Curve)  with an  
ExtensionLength=10  to extend both 
ends of the cyan curves and the top of 

each black arc, press Enter  to complete 

the command.  

 
Each arc is extended at each end using the existing arc radius.  

The goal is to extend the arcs enough that they will intersect one another as in the illustration. The exact 
amount is not critical.  

5  Change to the 04 Surfaces  layer.  

6  Use the  Revolve  command (Surface 

menu: Revolve)  to make surfaces 
from two adjacent extended vertical 
curves.  

7  Snap to the center of the base curve 
to place t he Start of revolve axis . 

8  Press Enter  to use CPlane z - axis 
direction  for  the End of revolve 

axis .  
  

If you are in a perspective viewport, this option will automatically set the axis vertical and save the trouble of 
locating the second point.  

1  Pick the Start angle  as shown in the 
image  that is somewhere outs ide the 
span of the desired final surface. 
Make sure Ortho  is not on at this 
stage.  

The goal is to make a surface that is 

larger than will eventually be 
needed to make the box , so the 
exact starting and ending points are 
not critical.    

2  Pick another point for Revolution angle  to create the vertical surface.  
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3  Create an adjacent vertical surface in  
the same way.  

  

 

  

4  Use the MX  and MY aliases you made on the first day to Mirror  each of 
the surfaces around the origin.  

 

To make the t op  surface  

In this example,  we will make the top surface by revolving one of the top curves around the center of the other 
top curve. Since we will be working in the perspective view, it will be necessary to change the construc tion p lane 
for that viewport.  

1  Use the  Revolve  command (Surface 
menu: Revolve)  to make the top 
surface from the longer top arc.  

2  Snap to the center of the shorter top 
arc  in the Right vi ewport  to place 

the Start of revolve axis . 
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3  Press Enter  to use CPlane z - axis 
direction  for  the End of revolve 

axis .  

4  Pick the Start angle  as shown . 

5  Pick another point for Revolution 
angle  to create the top  surface.  

  

6  Use the CutPlane  command (Surface 
menu: Plane  > Cutting Plane)  to 
make a cutting plane at the origin in 

the z -axis.  

  

To make the surfaces into a solid  

1  Use the CreateSolid  command (Solid 
menu : Create Solid)  to join and trim 
the surfac es into a closed solid . 

 2  Use the Fillet Edge  command (Solid 
menu: Fillet Edge  > Fillet  Edge)  to 

fillet the edges . Set the  

CurrentRadius  to 15 , select the four 
vertical edges, and press Enter  to 
make the fillets.  

  

3  Repeat the FilletEdge  command  to 

fillet the top edges. Set the 
CurrentRadius  to 10 ,  select the 
eig ht top edges, and press Enter  to 
make the fillets.   

The resulting surface is very clean 
and smooth with no hard edges.  

  

Not e:  You may notice a defect in a shaded viewport at one or more of the 
corners. This is a render mesh related defect. There is nothing wrong 

with the geometry.  
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To fix the mesh  

1  Use the Options  command to change the mesh 
settings.  

2  On the Mesh  page, change to a Custom  mesh.  

Use the settings on the right.  

 
The visual defect goes away.  
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6 Modeling with history 

History allows editing or updating objects by editing the input geometry 
that was used to create the objects. History is useful when there is a need 
to edit the input of a command or when transformed copies of an object 

need to stay matched to the original. Only certain commands support 
history.  

A list of commands in Rhino that support history is on page 86.   

History is not the same as a ñfeatureò or ñparametric.ò History information is saved in the Rhino  *.3dm file.  

A simple example would be the following:  

 
Draw a circle.  

 
Turn on Record History  
and Array  the circle.  

 
Scale  the original.  

 
Watch the arrayed circles 
update.  

Exercise 19 ðHistory introduction  

To make a lofted surface  

1  Open  the model 
History_Intro .3dm .  

2  Select the four cyan colored curves.  

3  Start the  Loft command (Surface  
menu: Loft ) , select Normal  style, 

and click OK .  

Loft the curves to generate a 
smooth surface.  

  

4  Turn on the control points and edit the surface.  

Turning on surface control points allows the surface to be edited directly as always.  Howe ver editing the 

input curves does nothing to change the surface.  

5  Undo  or delete  the loft.  
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Activating  h istory  

History recording is off by default. It must be turned on before running a command to record history for that 

command. The status of history recording is indicated on the Record  History  pane on the status bar. If the text 
in this pane is bold, recording is active. Click the pane to change the status.  

To record history for a particular command, click the Record  Hi story  pane, and then start a command that pays 
attention to history.  

Why is history off by default?  

¶ Unpredictable  results.  For  example,  if  you  Copy  with  history  and  make  a change,  all  of  the  children  start  to  
update.  

¶ File  size  is larger  with  history  enable d.  

To make a lofted surface with history  

1  Click in the Record History  pane in 
the status bar to make it bold and 
active.  

2  Select the four cyan colored curves.  

3  Start the  Loft command (Surface  
menu: Loft ) , select Normal  style, 

click OK . 

Notice the Record History  pane is 
no longer bold once a command has 
run.  

  

4  Select one of the input curves and 

move it.  

The loft surface updates to reflect 
this new position.  

5  Turn on control points of the input 
curves.  

6  Edit the points and the surface will 

update.  

  

7  Select the curves  and Rebuild  (Edit 
menu: Rebuild)  them to 10  points.  

The lofted surface updates to reflect 

this change as well. Changing 
degree of the parent curves will also 
change the degree of the child 
surface in that direction.  

8  Undo  th e three previous steps.  

  

Steps in the History chain  

¶ The command  must  support  History.  A list  of  commands  that  support  History  is on the  next  page.   

¶ History  recording  must  be active  when  the  command  is actually  run.  By default,  History  recording  is turned  
off  and  must  be activated  each  time  a command  is run  for  which  the  user  wants  to  record  history.  

¶ History  updating  must  be on.  This  is on  by  default.  When  it  is on,  edits  to  input  objects  are  immediately  
reflected  in  the  updated  output.   
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¶ History  can  be nested;  for  example,  a curve  can  be projected  onto  a lofted  surface,  and  the  curve  will  follow  
the  changes  to  the  lofted  surface.  

To pr oject a curve onto a surface with history  

This part of the exercise will demonstrate an example of nested history. We will be projecting the wheel cutout  
curves onto the lofted surface.  

1  First, we will change the CPlane for 
the perspective viewport. On the 
CPlane s  toolbar tab, click Set 

CPlane  World Right  . 

2  Click in the Record History  pane in 
the status bar to make it active.  

3  Use the Project  command  (Curve 
menu: Curve from Object  > Project)  
to project the two wheel cutout 

curves onto the lofted surface.  

  

4  Set  the CPlane  back to World Top (CPlanes toolbar tab, Set CPlane  
World Top) . 

5  Select one of the input curves for the loft and move it .  

The projected wheel cutout curves update to follow  the surface.  

 

Note :  Any editing of the outputs will 'break' History and the connection between inputs and outputs will be lost. 

Rhino will p ut up a warning box when this happens and the user can either Undo to restore the 

connection, or continue editing and accept the break in History.  
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History enabled commands  

Transforms Surfacing Solid Curve from object Annotation Point 

Array  

ArrayCrv  

Array CrvOnSrf  

ArrayPolar  

ArraySrf  

Bend (Copy option)  

Copy  

Orient (Copy option)  

OrientCrvToEdge (Copy option)  

OrientOnCrv (Copy option)  

OrientOnSrf (Copy option)  

Rotate  (Copy option)  

Scale (Copy option)  

Mirror (Copy option)  

Flow  

FlowAlongSrf  

ProjectToCPlane  

Rema pCPlane (Copy option)  

Rotate (Copy option)  

Rotate3D (Copy option)  

Scale (Copy option)  

Scale1D (Copy option)  

Scale2D (Copy option)  

ScaleByPlane (Copy option)  

ScaleNU (Copy option)  

SetPt  

Shear  

Stretch  

Symmetry  

Taper (Copy option)  

Twist  

EdgeSrf  

ExtrudeCrv  

Ext rudeCrvAlongCrv  

ExtrudeCrvTapered  

ExtrudeCrvToPoint  

ExtrudeSrfToPoint  

ExtrudeSrfAlongCrv  

ExtrudeSrfTapered  

Loft  

NetworkSrf  

OffsetSrf  

Patch  

PlanarSrf  

RailRevolve  

Revolve  (Copy option)  

Ribbon  

Sweep1  

Sweep2  

TweenSurfaces  

Pipe 

Slab  

ExtrudeSrf  

ArcBlend  

Blend  

Crv2View  

CSec 

CrvThroughPolyline  

CrvThroughPt  

Helix (AroundCurve option)  

Intersect  

Offset  

Project  

Pull  

Spiral (AroundCurve option)  

TweenCurves  

Dim  

DimAligned  

DimAngle  

DimArea  

DimCurveLength  

DimDiameter  

DimOrdinate  

DimRadius  

DimRotated  

Hatch  

Divide  

History - related  commands  

History  

HistoryPurge  

SelObjectsWithHistory  

SelChildren  

SelParents  

 

 
History toolbar  

History Options  

Inputs to a History -enabled command are called Parents  in Rhino and the outpu ts are called Children .  

Right -click the Record  History  pane to change the following options:  

Always Record History  

This option c hanges the default behavior so any eligible command will always record history. Use this option 
with caution. In addition to un necessarily increasing the file size, it can lead to unexpected behavior. To clear 
history on particular objects or on all objects, use the HistoryPurge  command.  
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Update Children  

Causes child objects to update each time the parent object changes. This incre ases the time it takes to update 
complex objects. For very complex edits on the parent objects, turn off updating, make the changes, and then 

turn Update Children on so that the update happens only once.  

Lock Children  

This option s ets child objects to a lo cked state. Since directly editing the child objects breaks the connection to 
the parent objects, locking the child objects prevents accidental editing. In addition, selecting child objects can 
be cumbersome if they are in the same location as the parent o bjects. Locked child objects still update when 

the parent objects are edited.  

History Break Warning  

This option d isplays a warning if an operation breaks the connection of a child object to its parent objects. The 
Undo command will restore history.  

Use the  History  command to control history recording, updating, locking,  and warnings . 

To change history options  

1  Click on a curve to get the multi -select box.  

If you edit the surface in any way, History for the object will bre ak and 
Rhino will warn you about this.  

2  Selec t  the surface and drag it. Rhino will warn you that dragging broke 

history . Click OK .  

 

Make sure to  Undo  after getting a ñbroken Historyò warning to restore 
the connection between inputs and output.  

 

3  Right -click in the Record History  pane and check Lock Ch ildren .  

This will make it impossible to edit a child in any way that will break 
history, but you can select it to change its object properties  or layer, 

etc.  
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7 Advanced surfacing techniques 
There are an infinite number of complex and tricky surfaci ng problems. In this chapter, we will look at several 
'tricks' that help in getting certain types of surfaces built cleanly. The goal, apart from showing you a few specific 
techniques used in these examples, is to suggest ways in which the Rhino tools can be combined creatively to help 
solve surfacing problems.  

In this chapter,  you will learn to make soft domed button shapes, creased surfaces, and how to use curve - fairing  
techniques.  

Dome - shaped buttons  

The surfacing goal in this exercise is to create a do me on a shape like a cell 

phone button where the top must conform to the general contour of the 
surrounding surface but maintain its own shape as well. There are a number of 
ways to approach this; we will look at three methods.  

 

Exercise 20 ðSoft domed buttons  

1  Open  the model Button Domes.3dm .  

The key to this exercise is defining a custom construction plane that represents the closest plane through t he 
area of the surface that you want to match. Once you get the construction plane established, there is a 
variety of approaches available for building the surface.  

There are several ways to define a construction plane. In this exercise,  we will discuss  four methods: 

construction plane through three points, construction plane perpendicular to a curve, construction plane 
tangent to a surface, and fitting a plane to an object.  

2  Use OneLayerOn  to turn on the Surfaces to Matc h  layer to see the surface that determines the cut of the 

button.  

To create a custom construction plane using three points method  

1  Start the CPlane  command with the 

3Point  option (View menu: Set 
CPlane  > 3 Points ) . 

2  In the Perspective  viewport, using 
the Near  object snap, pick three 
points on the edge of the trimmed 
hole.  

The construction plane now goes 
through the three points. Notice the 
construction p lane  origin is at the 

first point.  

  

3  Rotate the Perspective  viewport to see the grid aligned with the trimmed hole.  
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To create  a custom construction plane perpendicular to a curve  

With a line normal to a surface and a construction plane perpendicular to that normal line, you can define a 
tangent construction plane at any given point on the surface  

1  Start the CPlane  command with the 
Previous option (Viewport title right -
click menu: Set CPlane  > Undo 
CPlane Change) .  

2  Use the Line  command with the 
Normal  option (Curve menu: Line  > 
Normal to Surface)  to draw a line  

normal to the underlying surface at a 
point near the center of the trimmed 
hole .    

Set the command - line option for IgnoreTrim s=Yes  so that the line can be drawn from a point inside the 

trimmed hole in the surface.  

3  Start the CPlane  command with the 
Curve  option (View menu: Set 
CPlane  > Perpendicular to Curve) .  

4  Pick the normal.  

5  Use the End  object snap and pick the 
end of the normal where it intersects 

the surface.  

The construction plane is set 
perpendicular to the normal line.    

To create a custom construction plane to a surface  

This function sets the construction plane to match a surface. The placement is constrained so that the construction 

plane is t angent to the surface at any given point on the surface. This works like the previous method without the 
need to make the normal line.  

1  Start the CPlane  command with the 
Previous option (Viewport title right -

click menu: Set CPlane > Undo 
CPlane Change) .  

2  Delete  the Normal  line.  

3  Start the CPlane  command (View 
menu: Set CPlane  > Origin)  with the 
Surface  option.  

4  Pick t he surface.  

5  For the  CPlane origin , change the 

IgnoreTrims  option to Yes , then 
pick a point near the center of the 
hole.  

6  For the X axis direction , pick a point 
in the direction of the long dimension 

of the trim curve.  

The construction plane is set 
tangent to the surface at the origin.    
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To create a construction plane fit through points  

Using the PlaneThroughPt  command to create a surface through a sample of extracted point objects will  
generate a plane that best fits the points. The CPlane  command with the Object  option places a construction 

plane with its origin on the center of the plane. This is a good choice in the case of the button in this file. There 
are several curves from which  the points can be extracted ðthe edge of the button itself, or from the trimmed hole 
in the surrounding surface.  

1  Start the CPlane  command with the Previous  option (Viewport title 
right -click menu: Set CPlane  > Undo CPla ne Change).  

2  Turn on the Surfaces  and the Curves  layer.  Make the Curves  layer the 

current layer.  

3  Start the DupEdge  command ( Curve menu  > Curve from objects > 
Duplicate edge)  to duplicat e the top edge of the button surface, press 
Enter .  

 

4  Copy  the duplicated curve vertically 
twice.  

The vertical position of these curves 
will determine the s hape of the 

button.  

5  Use the Divide  command (Curve 
menu : Point Object>Divide curve 
by>Number of segments)  to mark off 
the top copied curve with 50 points.  
Set the command line options to 
Split=No  and GroupOutput=Yes  

  

6  Use SelLast  to select the points just 
created.  

7  Use the Plan eThroughPt  command 
(Surface menu: Plane  > Through 

Points)  with the selected points.  

8  Press the Delete  key to delete the 
point objects that are still selected.  

A rectangular plane is fit through 
the selected points.    

9  Use the CPlane  command with the Object  option (View menu: Set CPlane  > To Object)  to align the 
construction plane with the plane.  
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10  From the View  menu, select Set CPlane , click Named CPlanes , then 
click the Save As  icon to save and name the custom construction plane 

Button Top .  

This will allow you to restore this cu stom construction p lane at any 
time.  

11  Delete  the surface you used to create the Button Top  construction 
plane.   

 

To loft the button  

1  Set the Surfaces  layer as the current layer.  

2  Use Loft  to make the button.  

3  Select the top edge of the surf ace and the two copied curves.  

4  After selecting the curves, click Point  on the command line.  

5  For the  Loft end point , m ake sure the view that has the custom 
construction p lane is the curr ent view, then type 0  (zero) and press 
Enter .  

The loft will end at a point in the middle of the plane, which is the origin 
of the construction plane.  

 

6  In t he Loft  Options  dialog, under 
Style , choose Loose , press OK . 

With the Loose  option, the 
control points of the input curves 

become the control points of the 
resulting surface, as opposed to 
the Normal  option, in which the 
lofted surface is interpolated 
thro ugh the curves.  
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7  Turn on control points on the lofted surface.  

8  Select the next ring of points out from the 

center.  

Select one point and use SelV  or SelU  to 
select the whole ring of points.  

9  Use the SetPt  command (Transform menu: Set 
XYZ Coordinates )  to set the points to the same 
Z-elevation as the point in the center. Set the 
radio button in the dialog to Align to CPlane .  

Remember, this elevation is relative to the 
current construction plane.  

  

Note:  You can use History  when creating the loft, in which case the SetPt  operation should be applied to the 

topmost curve in the loft, not to the loft surface control points.  

To use a patch su rface to make the button  

1  Use the  DupEdge  command to duplicate the top edge of the surface.  

2  Move  the duplicated curve in the World Z -direction a small amount.  

3  Use Divide  to mark off this curve with 50  points as before.  

4  Use the PlaneThroughPt  command with the selected points, and then  

delete the points like the previous exercise.  

5  Use the CPlane  command with the  Object  option to set the construction 
plane to the planar surface.  

6  Make a circle or ellipse  centered on the origin of the custom construction 
plane.  

 

7  Use the Patch  command, selecting 
the top edge of the button and the 
ellipse or circle.  

The surface is tangent to the edge 
and concave on the top.  

  

The size and vertical position of the 
circle/ellipse will affect the shape of 

the surface.  
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Note:  If you recorded History  for the patch, you can select the ellipse and move it up and down or scale it in 

two dimensions to modify the patch shape.  
 

The Gumball  control is perfect for making these adj ustments. Make sure the Gumball alignment is set to 

CPlane .  

To use a rail revolve surface to make the button  

1  Use the DupEdge  command to duplicate the top edge of the surface.  

2  Move  the  duplicated curve in the World Z -direction a small amount.  

3  Set a CPlane  to this curve using Divide  and PlaneThroughPt  as before.  

4  Use Line  with the Vertical  option to 
make a line of an y convenient length 

from the origin of the construction 
plane down towards the button 

surface.  

5  Use the Extend  command (Curve 
menu: Extend Curve  > By Line)  to 
extend the edge at the seam through 
the rectangular surface.  

  

6  Use the Intersect  command (Curve 
menu: Curve From Objects  > 
Inte rsection)  to find the intersection 
between the extended line and the 
rectangular surface.  

7  Use the Curve  command to draw a 

curve from the end of the normal 

line, using the intersection point as 
the middle control point, t o the end 
of the seam to use as a profile curve.    

8  Start the RailRevolve  command 
(Surface m enu: Rail Revolve) . Set 

the ScaleHeight  option to Yes .  

9  Select the curve you just created (1) 
as the profile curve, the top edge of 
the surface (2) as the path curve. 
Select the upper end of the vertical 
line (3) as one e nd of the revolve 
axis and the lower end as the other 

end of the revolve axis.    

10  RailRevol ve  does not pay attention 

to continuity during the surface 
creation so you will need to match 
the new surface to the vertical sides 
of the button for tangency or 
curvature with the MatchSrf  
command.  
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Creased surfaces  

Often a surface needs to be built with a crease that may start at 

a particular angle and change to another angle or diminish to 
zero. The crease in the car body in t he image is an example of 
this. The  following exercise covers two possible situations.  

 

Exercise 21 ðSurfaces with a crease  

The key to the following exercise is to get two sur faces that match with different continuity at each end. At one 

end, we will match the surface with a 10 -degree angle, and at the other end, we will match the surface with 

tangency continuity. To accomplish this we will create a dummy surface at the correct  angles and use this to 
match the lower edge of the upper surface. When the dummy surface is deleted or hidden,  the crease appears 
between the two surfaces we want to keep.  

1  Open  the model Crease 01.3dm .  

2  Turn on the Curve  and Loft  layers.  

3  Make the Loft  layer current.  

4  Use the Loft  command  to make a surface from the three curves.   

The Loft  command remembers the settin gs across sessions. Make sure 
the Loft style is set to Normal and Do not simplify . 

 

5  We are going to make a surface that 

includes all the curves but has a creas e 
along the middle curve.  

Use the middle curve to Split  the 
resulting surface into two pieces.  

6  Use the ShrinkTrimmedSrf  command 
(Surface menu: Surface Edit Tools  > 
Shrink Trimmed Surface)  on both 

surfaces.    

With a  surface that results from a split 
at an isocurve , shrinking it will allow the 
edge to be an untrimmed edge because 
the trim corresponds to t he natural 

untrimmed surface edge.  

By trimming with a curve used in the 

loft, the curve is in effect an isocurve.  

You can also use the Isocurve option in 
the Split  command when the object to 
be split is a single surface.  

  

7  Hide  the lower surface and turn off the Curve  layer.  
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To create the dummy surface  

We will change the top surface by matching it to a new dummy  surface.  

The dummy  surface will be made from one or more line segments along the bottom edge of the top surface that 

are set at varying angles to it.  

To get a line that is not tangent but is at a given angle from tangent, the easiest method i s to use the transform 
tools to place the line tangent and then to rotate it by the desired increment.  

1  Change to the Dummy Curve  layer.  

2  In the Top  viewport, draw a line  20  units long.  

 

3  Start the  OrientCrvToEdge  command 
(Transform menu: Orient  > Curve To 
Edge) . 

4  For the  Curve to orient, select the line.   

5  For the  Target surface edge , s elect the 
lower edge of the surface.  

  

6  For the Pick target edge point , change the command line option to Copy=Yes , and s nap to an  endpoint of 
the edge.  

7  For the Pick target edge point ,  snap to the other endpoint.  

8  Press Enter .  

The result should look like the image s above.  

9  In the Perspective  viewport, use the 
Viewport title  right -click  menu and 
select Set CPlane > Perpendicular to 

curve  to set a construction plane 
perpendicular to the l ower edge of the 
surface, snapping to the left end point of 
the lower edge for the construction p lane 
origin . 

  



C H A P T E R  7  A D V A N C E D  S U R F A C I N G  T E C H N I Q U E S  

Rober t  McNeel  &  Assoc ia tes  93  

Set up the rail line  

1  Select the line segment at the left end and start the Rotate  command. Set 

the center of rotation at the origin of the new custom construction p lane. 

Rotate the segment 10  degrees.  

The result should be like the image on t he right.  

 

2  Make the Dummy Surface  layer current.  

3  Use the Sweep1  command (Surface menu: Sweep 1 Rail)  to create the 
dummy su rface.  

4  Select the lower edge of the upper surface (1) as the rail and the two line 

segments (2 & 3) as cross -section curves.  

Make sure to use the surface edge and not the original input curve as the 

rail for the sweep.  

 

5  In the Sweep 1 Rail Options  
dialog, under Style , choose Align 

with surface .  

This option causes the sweep 
surface to derive from the cross 
section curves its angle relative to 
the base surface at its edge. A 
shape curve tangent to the base 

surface will hold that tangency as 

it sweeps along the edge, unless 
another shape curve with a 
different angle to the surface is 
encountered, in which case there 
will be a sm ooth transition from 
one to the next  

 

 

To match the surface to the dummy surface  

1  Use the MatchSrf  command to match the upper surface to the dummy 

surface.  

2  Select the lower edge of the upper surface.  
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3  Select the upper edg e of the dummy 
surface.  

4  In the Match Surface  dialog, choose 
Tangency  and check Match edges 
by closest point .  

This will keep distortion to a 
minimum.  

 

 

5  Show  the lower surface and hide  the dummy surface.  

 

6  Join  the lower sur face with the upper surface.  

Because the surfaces are untrimmed, you have the option to merge the 
surfaces back into one surface.  

The crease fades smoothly from one end to the other of the polysurface. If 
more control is needed over the angles of the creas e, more segments can 
be placed to create the dummy surface.  

 

Exercise 22 ðSurfaces with a crease (Part 2)  

 In this exercise,  there is no convenient relationship between the crease c urve and the surface. While similar to 
the other example, the upper surface is made with a two - rail  sweep.  
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To create a crease with trimmed surfaces  

1  Open  the model Crease  02.3dm.  

2  Use t he Line  command (Curve menu: Line  > Single Line)  to draw a single 
line anywhere in the  top or perspective viewport.  

We will use this line to make a dummy surface.  

 

3  Use the OrientCrvToEdge  command (Transform menu: Orient  > Curve 
to Edge)  to copy  the curve for the dummy surface to the upper edge of 
the lower surface.  

4  Place a line at each end of the edge and somewhere in the midd le of the 

edge.  

 

5  Move  each line segment by moving its 
upper end to the lower end of the same 
segment.  

 
 

6  Use the CPlane  command (View menu: 

Set CPlane  > Perpendicular to Curve)  to 
set the construction plane to align with 
the line at the left of the surface.  

 

 

7  Use the Rotate  command (Transform menu: Rotate)  to rotate the line 15  
degrees as shown in the illus tration on the right.  
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8  Repeat these steps for the line in the middle of the surface . 

 

To make the d ummy surface  

1  Use the Sweep1  command to create the dummy surface.  

2  Select the upper edge of the lower surface as the rail and the three line 
segments as cross -section curves. Use the Align with surface  style for 

the sweep.  

 

3  Hide  the original surface.  

 

4  Use the Sweep2  command to make the upper surface.  

Choose the upper edge of the dummy surface as a rail (1)  and the long 
curve at the top as the other rail (2) . 

Choose the curves at both ends as the cross -section curves (3)  and (4) .  
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5  In the Sweep 2 Rails Options  
dialog, for the Rail continuity  of 

edge A , choose Tangency . 

6  Delete  the dummy surface.  

7  Use Show  or Show Selected  
(Edit menu>Visibility>Show 
selected)  to show the original 
lower surface.  

8  Join  the lower surface with the 

upper surface.  

 

 

Curve fairing to control surface quality  

Curves in Rhino can come from many sources, they can be :  

¶ Created  in  Rhino  directly  

¶ Imported  from  digitized  data  

¶ Im ported  from  another  applica tion  

¶ Secti on  curves  generated  from  a mesh  

It is important to understand that many of these curves need to be optimized  for quality .  

Fairing is a technique used to simplify curves while improving their curvature graphs and keeping their shape 
within tolera nce. It is especially important to fair curves that are generated from digitized data, intersections, 

extracted isocurves, or curves from two views.  

Generally,  curves that are single -span curves work better for this process. A single span curve is a curve that has 
one more control point than the degree. For examples a degree 3 curve with 4 control points, a degree 5 curve 
with 6 control points, or a degree 7 curve with 8 control points.  

To analyze a lofted surface with curvature analysis  

1  Open  the model Fair Curves.3dm .  

2  Select the curves and use the Loft  
command (Surface menu: Loft)  with 
Style  set to Normal  and Cross -

section curve options  set to Do not 
simplify  to make a surface.  

The sur face is very complex. It has 

many more isocurves than are 
needed to define the shape , because 
the knot  structures of the curves are 
very different.   

The surface also has compound 
curvature.  
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3  Select the lofted surface and start the CurvatureAnalysis  command (Analyze menu  > 
Surface>Curvature analysis) .  

This creates a so-called  ñFalse colorò display using th e same type of analysis meshes 
as the Zebra  command.  

The amount of curvature is mapped to a range of colors allowing you to analyze for 
areas of abruptly changing curvature or flat spots.  

 Choose Mean  from the Style  drop down.  

This style is useful for s howing discontinuities in the curvature ðflat spots and dents.  
The mean is between the two curvature circle values  at each point , mapped to a color 

value.  

4  Push the AutoRange  button.  

 

 

5  Click  the Adjust mesh  button  and adjust the Minimum initial grid 
quads  to have at least 5000  minimum grid quads to ensure a smooth 
display of the color range.   

 

Note the streaky and inconsistent colors on the surface.  This indicates 

abrupt changes in the surface.  

6  Undo  the loft.  
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To rebuild the curves  

1  Change to the Tangency Direction  

layer.  

2  Use the Line  command (Curve  menu : 
Line > Single Line, )  with the 
Extension  option, to m ake a line  that 
maintain s the tangency direction  of 
an original curve from each end point 
and coming back towards the curve, 

any length.  
  

Make the lines long enough to cross one another.  

3  Change to Rebuilt Curves  layer, and Lock  the Tangency Direction  

layer  

4  Use the Rebuild  command (Edit menu: Rebuild)  to rebuild the curv e.  

Although there is a Rebuild  option in the Loft  command, rebuilding the 
curves before lofting them gives you control over the degree of the 
curves as well as the number of control points.  

5  In the Rebuild Curve  dialog, c hange the Degree  to 5  and the Point 
Count  to 6  points. Uncheck Delete  input , check Create new curve on 

Current layer . Click the Preview  button. Note how much the curves 
deviate from the originals.  

 

This makes the curves into single -span curves. Single -span curves are Bézier  curves. A single -span curve is 
a curve that has degree +1 control points. While this is not necessary to get high quality surfaces, it 
produces predictable results.  

6  Lock the Original Curves  layer. We 
need to see these curves but we do 

not want to be able to select them.  

7  Select one of the rebuilt curves, and 
turn on the Control points  and 
Curvature graph .  

8  Fair the curve by adjusting points 
until it matches the original curve  

closely enough.    

Start by moving the second point from each end of the rebuilt curve onto the tangent line. Use the Near 
object snap to d rag along the tangent line.  

9  Check the curvature graph to make 
sure the curve has smooth 

transitions.  

The curves are fair when the points 
are adjusted so the rebuilt curves 
match the original locked curves 
closely, with good graphs.  

10  Fair the other cur ves the same way.  
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Here are some things to keep in mind when adjusting the curves:  

¶ If  you  want  to  keep  the  curve  tangent  direction  consist ent  with  the  original  curves,  make  sure  the  second  
point  from  each  curve  stays  on  the  green  tangent  direction  line -  only  move  these  points  with  the  Near  

object  snap  pulling  the  point  onto  the  line.  

¶ The DragMode  command,  set  to  ControlPolygon  will  constrain  point  dragging  to  the  curve  control  
polygon -  you  can  use  this  tool  to  keep  the  tangent  directions  constant.  

¶ Where  possible,  when  fairing  a set  of  curves  to  be used  as input  to  a single  lofted  surface,  try  to  keep  the  
control  point  arrangement  on  each  curv e similar  to  the  neighboring  curves.  This  will  help  keep  the  surface  
nicely  aligned.  

¶ When  control  point  adjustment  becomes  difficult  due  to  the  small  movements  needed,  try  using  the  Nudge  

keys  to  nudge  the  points  by  small  amounts.  See Help  for  more  informa tion  about  Nudge .  

¶ You can  also  use  the  Gumball  to  move  points.  When  fine - tuning  with  very  small  point  movements  needed,  
you  can  set  GumballDragStrength  to  something  less  than  100%  to  allow  larger  mouse  movements  to  
make  small  changes  in  the  point  locations . 

To use PointDeviation to visualize the deviation while you edit the curves  

1  Make a Points  layer and make it current .  

2  Select all of the original curves and start  the Divide  command (Curve 
menu: Point Object>Divide Curve by>Number of Points) . Set the 
Number of segments  to 32  and  GroupOutput=Yes .  

3  Deselect all  objects, and select the grouped points.  

4  Start the PointDev iation  command (Analyze menu: Surface>Point Set 
Deviation) , and at the Select curves, surfaces, and polysurfs to test  

prompt, select the, roughly faired, rebuilt curves.  

 

5  When the  Point /Surface Deviation  dialog pops up , 
set the numbers as follows:   

Good point = 0.1  
Bad point  = 0.5  
Ignore = 1.0  

The display shows the deviation between the points 
displayed on the original curves and the closest 
locations to these on the rebuilt curves.  

6  Lock the Points  and  the Original Curves  layer s. 

 

7  Continue to modify the rebuilt curves 
with the goal bein g that all points will 
turn blue, as good points . 

Note :  If you close the dialog,  you 
lose the display and you need to 

start over with PointDeviation .  
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To make a surface with fair curves  

1  Loft  the new curves.  

The shape and quality of the surface 
has very few isocurves but it is very 
close to the shape of the first 
surface.  

  

2  Analyze the surface with CurvatureAnalysis .  

Note the smooth transitions in the false color display, indicating smooth 
curvature transi tions in the surface.  
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8 Use background bitmaps 
This exercise describes the steps in creating a case for a small, hand held product , using bitmaps as templates. In 
this exercise,  we will focus on  making curves from bitmap images and using fairing techniques on the curves 
before making the surfaces.  

We will begin by taking scanned sketches and placing them in three different viewports. The three hand -drawn 
images need to be placed in their respecti ve viewports and scaled appropriately so that they match each other.  

You can align images more easily if they have been aligned and cropped so that they share the same length in 
pixels. It helps to darken and slightly reduce the contrast of images that ha ve a lot of bright white in them. This 

allows a greater range of colors to be seen against them when tracing them in Rhino.  

Exercise 23 ðHandset  

1  Open  the model Handset.3dm .  

2  From the Tools  menu, click Toolbar  Layout .  

3  In the Rhino Options  dialog, on the Toolbars  page, check  Background  Bitmap  to open the toolbar, and 

then  close the dialog.  

Use the toolbar buttons for the next part of the e xercise.  

The toolbar can also be accessed by flying out the Background Bitmap  toolbar from the Viewport Layout 
tab  across the top.  

4  It will make it easier in this exercise if you Split the Front Viewport horizontally  and  make the lower 
viewport the Bottom  view. You can re -align the views like the illustration below.  

 

5  In Rhino Options , on the View  page, in the Viewport properti es  section, check Linked viewports .  

This allows the viewports to stay aligned with each other when zooming and panning.  
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To place background bitmaps  

We will begin by making reference geometry to help in placing the bitmaps.  

1  Make a horizontal  line , from both 
sides of the origin of the Top  
viewport, 150 mm  long.  

2  Toggle the grid off in the viewports 
that you are using to place the 
bitmaps by pressing the F7  key.  

This will make it much easi er to see 

the bitmap.  

 
 

3  In the Front  viewport , use the BackgroundBitmap  command with the Place  op tion  (View menu: 
Background Bitmap  > Place)  to place the HandsetElevation.bmp .  

4  Use the BackgroundBitmap  
command with the Align  option  
(View menu: Background Bitmap  > 
Align)  to align the ends of the 
handset to the line. The command 

line prompts will tell you the steps to 
follow.  

The Align  option shows blips at the 
corners of the bitmap, so that it is 
precise to use Point  object snap  to 
specify them.  

  

Pick two points on the bitmap ðyou can zoom way in to pick a point very accurately at this stage.  

Pick the points at either extremity of the long shape. Next, you pick two points in space to which you wou ld 
like to have the image points just selecte d to correspond ðsnap to the end points of the 150 mm line.  

5  Change to the  Bottom  view.  

6  Use the same technique to place and align the Handset Bottom.bmp  in 
the Bottom viewport.  
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7  Repeat these steps for the Top  viewport.  

 

To build the case  

The most useful tool for tracing freeform curves is a control point curve.  

Place the fewest number of points that will accur ately describe the curve. Do not  fall into the trap of trying to be 
100% accurate with every point placement. With some experience you will be able to place about the right 
number of points in about the right places and then point edit the curve into its final shape.  

In this example, the 2 -D curves can all be drawn quite accurately with a degree -3 curve using five  or at most six  
cont rol points.  

Remember to pay attention to the placement of the second points of the curves to maintain tangency across the 

pointed end of the object.  

1  In the Front  viewport, trace two 
curves to define the form of the cas e.  

The front view curves describing the 
top and bottom edges of the case 

should extend on the right past the 

form in the background image . 

2  In the Bottom  viewport, trace one 
curve to define the form of the case.  

  

Since the bottom view of the object 
is symmetrical,  you can make one 
curve.  Extend the curve past the 
background image approximately 
the same distance as you did with 
the curves in the front viewport.  
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3  Draw the curve in the Front  vi ewport 
that defines the parting line 

separating the top and bottom halves 

of the case.  

This curve is the front view of the 
plan viewôs edge curves. It should 
be extended to the right the same 
distance as the other edge curves.  

4  Trim  both bottom view and front 

view form curves with a single cutting 
plane or use the SetPt  command to 
set the points at the same plane.  

  

5  I n the Perspective  viewport, select 

the parting line curve and the outline 
curve  that you created in the Bottom 

viewport . 

6  Use the Crv2View  command (Curve 
menu: Curve From 2 Views)  to create 
a curve based on the selected curves . 

A 3 -D curve is created.  

  

7  Hide  or Lo ck  the two original curves.  

Now there are three curves.  

8  Turn on the control points for the 
curves.  

Notice  the number of control points 

and the spacing. This is an example 
of curves that need to be faired 
before you can create a good 
surface from them.    

9  Fair the curves, using the same 
technique as in the previous e xercise.  

10  Mirror  the 3 -D curve for the other 
side.  

The macros ! Mirror 0 1,0,0 and ! 
Mirror 0 0,1,0 are very useful for 

accomplishing this quickly if they 
are assigned to a command alias 

and if the geometry is symmetrica l 
about the x -  or y -axis.    
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11  Loft  the faired curves  with the 
Closed loft  option checked . 

Notice  the quality of the surface and 
how few isocurves there are.  

A closed loft will have a seam.  

  

To build the case (alternate technique  1)  

1  Undo  until your back to step 7  of 
the previous part of the exercise.  

2  Mirror  the 3 -D curve for the 

other side.  

3  Loft  the curves, using the 
Rebuild  option to  18  points . 

The isocurves all true up and 
everything looks clean, but if 
you look at the tip , it falls away 
from the input curves.  

The Rebuild  option does not 
sample more in areas of high 
curvature but just divides the 
curves up evenly.  

 

 

To fair  the surface  

1  Hide  the background bitmaps  and set the viewport to wireframe.  

2  Turn on surface points.  

 

3  In the top or bottom view, move points on one side of the surface in the 
y-direction to get the surface to match.  

A few points moved should do it.  

Now, how do we  get the other side exactly the same?  

4  Undo  all the moves and instead of moving the points, select opposite 

pairs of points and Scale1 D  in Y to move them symmetrically.  

The ba se of the scale should be a middle point, use Ortho to keep the 
scale axis true to Y.  
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5  Show the Organic toolbar  and use the Expand Y  and Compress Y  
nudge  cont rol s to do the same thing in small increments.  

These buttons are macros of Scale1D using the origin as the scale origin.  

 

6  Use similar techniques for adjustin g points  in the elevation view . Since the 
points in this view are  not symmetrical in the z -axis , do one side at a 
time , moving rather than scaling the points.  

Nudge keys or the Move in Z nudge controls in the Organic toolbar also 

work.  

 

To build the case u sing the CSec command (alternate technique 2)   

The CSec  command c reates cross -section curves through profile curves.  

1  Undo  back to  the four input curves .  

2  Start the CSec  command (Curve 
menu  > Cross section profiles) . 

3  Select the curves in order as if lofting 
them , make sure the Closed  option is 
Yes , press Enter  when done.  

4  For the Start cross - section line , i n 

Front  viewport , pick a point on either 
side of the 4 curves.    

5  For the End of cross - section line , use Ortho , and pick a point on the other side of the 4 curves.  

6  Continue this process until you have 6-10  cross -section curves, evenly 

spaced along the four  curves  

Make sure to add one section snapping to the end points at the open end 
of the set of curves.  
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7  Window the section curves and the original long curves . 

8  Start the  NetworkSrf  command (Surface menu > Curve Network)  to 

make the surface.  
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9 An approach to modeling 
A common question that users have when modeling, is ñWhere do I start?ò In this section,  we will discuss various 
approaches to the modeling process.  

There are two things to consider before your begin modeling: if reflections, fluid flow, air flow, or the ability to edit 
using control points are important in th e finished model, you will want to begin your models with geometry that 
consists of cubic (degree 3) or quintic (degree 5) curves. If these are not important, you can use a combination of 
linear (degree 1), quadratic (degree 2), cubic or quintic curves.  

St art with simple shapes, the details can be added later. Begin by creating layers for the different parts. This will 

help separate the parts for visualization, and help with matching the parts as you go.  

We will review different products to try to determin e which kind of surfaces are most important and some 
approaches to modeling the product.  

Exercise 24 ðCutout  

This exercise shows an approach to making a cutout surface that  blends 

smoothly and seamlessly into an existing curved surface. The new surface has 
an arbitrary relationship to the existing surface so the general strategy can be 
used in other cases.  

For this exercise, we have created additional models for each stage of the 
exercise. The models are for reference and include notes to exp lain the 
procedure for the steps in that stage of the exercise. There will be a note at 
each stage to indicate which model to open if needed.  

 

1  Open  the model Scoop.3dm .  

2  Make the Cut - out Curves  layer 
current, turn on the Original 

Surface  layer, and turn off the 

Completed Scoop  layer.  

3  In the Top  viewport, select the 
curves.  

4  Start the Project  command 
(Curve menu: Curve From 
Objects  > Project) . 

  

5  Select the s urface and press Enter .  

The curves will be projected onto the surface.  

6  Start the ExtendCrvOnSrf  command 

(Curve menu: Extend  Curve  > Curve 

on Surface) .  

7  For the  Curve to extend, select the 
outer curve on the surface.  

8  Select the surface.  

The ends of the curve are extended 

to the edge of the surface.  
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9  Use the Trim  command (Edit 
menu:  Trim)  to trim the curves with 

each other.  

10  Join  the three small curves into one.  

11  Copy  InPlace  the  surface  and hide 
the copy.  

12  Use the joined curve to trim  away the 
part of the surface that  is outside the 
curve.    

This leaves a small trapezoidal surface. This surface is a dummy that will be used to match to a new surface.  

13  Use the ShrinkTrimmedSrf  

command (Surface menu: Edit 
Tools  > Shrink Trimmed Surface)  to 

make this surface easier to see since 
it will reset the isocurves to the new 
surface size.  

  

To make the curves for the floor of the scoop (Op en  Scoop 001.3dm  if needed)  

Next , we will make a surface for the bottom of the cutout. The cutout is rounded at one end, but we will build a 
rectangular surface and trim it to be round at one end. This approach allows for a much lighter, more easily 
contro lled surface than trying hitting the edges exactly while building the surface.  

In this part, we will make one curve with as few points as possible that shows the shape of the part  that will 

become the bottom of the scoop. When making the curve, try to l ook  at it  from various views while you work. Use 
a degree 5 curve and six points for a very smooth curve. Check the curve with the curvature graph to get a nice 
fair curve.  

1  Use the Curve  command to d raw a 
control point cur ve in the Front  view. On 

the Status bar,  turn Planar  mode on.  
This will keep the curve  in a single plane 
for the moment . 

Snap the first point of the curve to the 
corner of the small dummy surface in 
any convenient  view. Then switch to the 
Front view to con tinue drawing.  

  

Draw the curve approximately tangent to the edge of the dummy surface and finish it lower, defining the 
shape of the flo or of the scoop.  
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2  Adjust the curve with point editing  to get 
the right shape in the Top view.  

Make sure to move the points only in 
the y-direction (Ortho will help), so that 
the shape in the Front view will not be 
altered .  

Make the curve approximate the 
outermost of the original curves and 
extend somewhat past the rounded end.    

3  Use the Match  command (Curve menu: 
Curve Edit Tools  > Match)  to match the 
curve with Curvature  continuity to the 
edge of the dummy surface.  

Edit the curve further if needed but be 
sure to use Match again if you have 

moved any of the first three po ints in 
the curve.  

4  Copy  the curve to the other edge.    

5  Adjust th e curves by moving the control 
points until they look the way you want, 
and then  Match  the curve to the edge of 
the dummy surface.  

If matching makes the curve distort too 
much add a knot and try again. Using 

the EndBulge  command and further 
point editing m ay be needed.  

  

To create the floor surface of the scoop  (Open Scoop 00 2 .3dm if needed)  

There are a few surfacing techniques that can be used to create the surface.  

A 2 - Rail Sweep  would be one 
obvious choice, using the new 
curves as rails and the edge of the 

dummy surface as the cross section. 
The advantage of this is that other 
cross -sections can be used to define 
the floor shape if desir ed.  

Since the rails are G2 to the dummy 

surface (Matched in the last 
sequence of steps),  the surface will 

be very close to G2 to the dummy 
surface when created.  

The MatchSrf  command could fix 
any discontinuity, if needed. This is 
a good way to go and you m ay wish 
to try it now.  

 
2-Rail Sweep using the new curves 
as rails and the surface edge as the 
cross -section.  

 
2-Rail Sweep using the new curves 
as rails and the surface edge as the 
cross -section with the simple sweep 
option checked.  

Another approach is to make a lofted surface between the two curves. The surface will need adjustment to match 
to the dummy surface and will provide the opport unity to explore some options in the MatchSrf  command so we 
will outline this method below.  
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1  Use the Loft  command (Surface 
menu: Loft)  to create the surface 

between the two curves.  

Because the lofted surface is flat, 
the re will be a slight gap at the 
edge of the dummy surface.  

  

2  Use the MatchSrf  command (Surface 

menu: Surface Edit Tools  > Match)  to 
match the lofted surface to the edge 
of the dummy surface for curvature.  

Use the Preview  button to see how 
the match will look.  

You may notice that the matched 

surface pulls around quite 
drastically to be perpendicular to 
the  target edge.  

  

If so, change the Isocurve adjustment  from Automatic  to Preserve 
isocurve direction , and try the Preview  again.  The surfa ce should 

now match with much less distortion.  

3  Use the Zebra  command (Analyze menu: Surface  > Zebra)  to check the 
continuity of the two surfaces.  

 

To make the s ides of the cutout (Open Scoop 00 3 .3dm if needed)  

To make the sides of the cutout, we will extrude the projected outline with 10 degrees of draft and trim it with the 
lofted surface.  

1  Select the outer projected curve.  

2  Use the ExtrudeCrv Tapered  command (Surface menu: Extrude 
curve  >Tapered)  to extrude the outer projected curve. Change the 
DraftAngle  to 10 . Pull the surface until it fully intersects with the bottom 

surface, but no more, and pick.  

If you extrude the surface too far, you might get a polysurface instead 

of a single surface.  

If this happens try to extrude again, but do not  pull so far.  

If you cannot  pull it far enough to penetrate the floor without making a 
polysurface, ext rude it a short distance instead.  
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3  Use the ExtendSrf  command (Surface menu: Extend Surface )  to extend 
it through the floor surface.  

The extruded surfac e is a very dense surface.  

4  Use the FitSrf  command  (Surface menu: Surface Edit Tools  > Refit to 
Tolerance )  to simplify the surface.  

A Fitting tolerance  of 0.001  with DeleteInput=Yes , ReTrim = Yes , 
UDegree = 3 , and VDegree = 3  should work well.  

 

To create the fillets  

Now the surfaces are ready to be filleted.  

1  Show  the main surface  and Hide  the dummy surface . 

2  Use the FilletSrf  command (Surface menu: Fillet Surface)  with a 

Radius=5 , Extend=No , and Trim=No  to make the fillets between the 
bottom surface and the sides.  

3  For the first surface to fillet , pick the bottom surf ace.  

4  Pick the side surface near the same  spot.  

5  Repeat this for the side surface and the original surface.  

The two fillets cross each other. We will trim them both back to their 
inters ection points.  

 

Where you pick matters.  

Trimming the fillet surfaces (Open Scoop 00 4 .3dm if needed)  

Both of the fillet surfaces are tangent to the tapered side of the scoop . W here the fillets cros s they are tangent to 

each other.  

If we trim the ends of the fillets to a plane, then the resulting trimmed edges will be tangent to each other. 
Trimming these surfaces will be helpful when creating the final surfaces that blend the fillets out between th e 

scoop and main surfaces.  

To create the plane, first make circles with the AroundCurve  option around one edge of the fillet surfaces, then 
make planar surfaces from the circles.  

1  Select the fillets and use the Invert 
Hide  button in the visibility toolbar 

to isolate them.  

2  Start the Circle  command, and use 
the AroundCurve  option. Set the 
Int  object snap  only.  

The AroundCurve  option forces 
the circle command to look for 
curves, includin g edge curves, to 

draw the circle around.    

3  Click on the upper edge of the lower surface and snap to t he intersection point . 
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4  Draw the circle out well past the 
width of the fillet surfaces.  

5  Use the PlanarSrf  command 
(Surface menu: Planar Curves)  to 
create a circular surface at the 
inters ection point.  

6  Repeat these steps for the other 
intersection.  

  

7  Trim  the fillets to  the surfaces.  

 

Trimming the sides of the scoop  

You can use the trimmed fillets to trim back the side surface of the scoop.  

1  Use Show Selected  to show the tapered side surface.  

2  Use the fillet surfaces as trimming objects to trim the excess from the side 
surface.  

It is often much faster to trim with curves than to use surfaces, 
especially if the surfaces are tangent to the object to be trimmed, as is 
the case with fillets .  

Duplicate the two edges that are in contact with the side surface to use 

as trimming objects if you have a problem.  

 

Trimming the main and floor surfaces (Open Scoop 00 5 .3dm if needed)   

The nex t task is to extend the edges of the fillets so that the main surface and the floor surface can be trimmed 
back. The inner, or lower, edge of the lower fillet will be extended off the end of the floor surface and the outer, or 

upper, edge of the upper fill et will be extended off past the end of the opening of the scoop as well. The extended 
curves will be projected onto the respective surfaces and used to trim them.  

1  In the Top  view, use the Extend  
command with the Type=S mooth  
option to extend both bottom ends of 
the lower fillet edge past the front of 

the floor surface.  

2  Use these curves, still in the Top  
view, to Trim  the outer edges from 
the floor surface.  
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3  Use Extend  to extend the outer 
edges of the upper fillet past the end 

of the floor surface.  

Note that in the Perspective view 
thes e extended curves are off in 
space at their outer ends.  

4  ShowSelected  the main surface if it 
is hidden.  

5  Project  the curves onto the main 

surface from the Top  view.  
  

6  ShowSelected  or turn on the  layer 
for the original curves and Project  
the line segment onto the main 

surface.  

7  Trim  the projected curves with one 
another so that they form a closed 
loop.  

8  Use the closed curves to Trim  a hole 
in the main surface.  

  

Set up the curves to create the surfaces  ( Open Scoop 00 6 .3dm if needed ) . 

We are now nearly ready to create the surfaces. As you can see there are nice rectangular gaps in the surfaces, 
we just need t o arrange the curves and edges surrounding the gaps for use in making a 2 -Rail Sweep or a surface 
from a Curve Network. Because one end of each open rectangle is bounded by the two tangent fillet edges, we 
need to create a single curve there to use as inpu t. We will  duplicate the four edges and join them into two s -
shaped curves. The other end of each rectangle is bounded by a portion of the end of the hole in the main surface. 
We will  split up that long edge into segments that correspond exactly to the end s of the rectangular openings.  

1  Use DupEdge  to create curves at the 
trimmed edges of the fillets.  

2  Join  these four edges into two 
curves.  

3  Use the Spli tEdge  command 

(Analyze menu: Edge Tools  > Split 
Edge)  and the End  object snap  to 
split the straight edge on the trimmed 
hole in the main surface to the end 
points of the floor surface's edge.    
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4  Use the SplitEdge  command to split 
the long edges at the endpoints of the 

fillet edges.  

This will help NetworkSrf  find a 
solution more quickly.  

  

5  Use the Sweep2  command with Rail continuity=Tangency  or the 
NetworkSrf  command to create the last two surfaces.  

The su rfaces start with the s -shaped curves that you duplicated and end 
with a flat line at the split edges.  

 

6  (Open Scoop 006.3dm  if needed )  
Join  the cutout surfaces and then 
trim a hole at the bottom.  

7  Mirror  and Trim  to get the other 
scoop.  

  

Extra cross section curv es  

Open Scoop 007.3dm ,  if needed .  

Use Sweep2  or NetworkSrf  to close the 
holes . Filling the  larger of the two holes  
may benefit from extra cross section 
curves. To add cross -sections, use the 
Blend  command to make tangent curves 
approximately one - third and  two - thirds of 
the way along the edges of the opening. 

Use these curves as additional input for a 

network surface.   


















































































































